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Read through this operating manual carefully before use and become familiar with the machine. 
Installation and start-up should not be carried out before reading and understanding this 
document. Keep this manual readily available so that you can reference it as needed. 
 

1.1  What Is the Purpose of this Operating Manual? 
This manual serves as an aid for the installation and operation of the product and supports the 
technical staff with all operating and maintenance tasks to be performed. Furthermore, this 
manual is aimed at preventing dangers to life and health of the user and third parties. 
 

1.2  Who Is this Operating Manual Targeted to? 
The operating manual provides a code of conduct for personnel tasked with the set-up, 
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with 
respect to the operation of gas engines and basic knowledge of electronic ignition systems are 
necessary. Persons who are only authorized to operate the gas engine shall be trained by the 
operating company and shall be expressly instructed concerning potential hazards. 
 

1.3  Which Symbols Are Used in the Operating Manual? 
The following symbols are used in this manual and must be observed: 

 

Example 

This symbol indicates examples, which point out necessary handling steps 
and techniques. In addition, you receive additional information from the 
examples, which will increase your knowledge. 

   

 

Notice 

This symbol indicates important notices for the user. Follow these. In 
addition, this symbol is used for overviews that give you a summary of the 
necessary work steps. 

   

 

Warning 

This symbol indicates warnings for possible risks of property damage or 
risks to health. Read these warning notices carefully and take the 
mentioned precautionary measures. 

   

1 GENERAL INFORMATION
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Danger 

This symbol indicates warnings for danger to life, especially due to high 
voltage. Read these warning notices carefully and take the mentioned 
precautionary measures. 

  
 

1.4  Which Abbreviations/Acronyms Are Used in the Operating Manual? 
In the manual or the user interface, the following abbreviations / acronyms are used. 

Abb. Term Description Explanation 

ADV Advance Advanced with respect 
to top dead center 

Indicates the direction for 
timing 

ASC Automatic Spark 
Control 

Automatic spark control

ASO Auxiliary  
Synchroni- 
zation Output 

 
Output for synchronizing the 
MIC5 and other controllers 

CAN  
Bus 

Controller Area 
Network Bus 

Bus for control 
devices / networks 

Asynchronous serial 
connection system for linking 
control units 

CE Conformité 
Européenne 

Conformity with EU 
directives 

Mark based on EU legislation 
for certain products in 
conjunction with product safety

CPU Central Processing 
Unit 

Central processing 
unit 

  

CSA Canadian Standards 
Association 

Organization that defines 
standards, inspects products 
for safety compliance, and 
issues pertinent certifications. 

DC Direct Current Direct Current   

DetCon Detonation Control 
System 

Detonation control 
system 

Serves to prevent major engine 
damage that can be caused by 
knocking combustion. 

EMI Electromagnetic 
Interference 

Electromagnetic 
interference  

  

EMC Electromagnetic
Compatibility 
 

Compatibility of electrical or 
electronic equipment items 
with their surroundings 
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Abb. Term Description Explanation 

GPI General purpose input Multi-purpose input 

GPO General Purpose 
Output 

General Purpose 
Output 

HV High voltage High voltage

°cranksh
aft 

Crankshaft angle in 
degrees 

Unit for the rotation angle of 
the crankshaft 

LED Light Emitting Diode Light emitting diode Light emitting electronic semi-
conductor 

MIC MOTORTECH Ignition 
Controller 

MOTORTECH
ignition controller 

MICT MOTORTECH 
Integrated 
Configuration Tool 

Software for MIC5 configuration

ATDC After top dead center

TDC Top dead center

POT Potentiometer Continuously adjustable 
potential divider 

PWR Power Output / current

RET Retard Retarded with respect 
to the top dead center 

Indicates the direction for 
timing 

USB Universal Serial Bus Serial connection system to 
link a computer to external 
devices 

BTDC Before top dead center
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2.1  General Safety Instructions 
The following safety instructions must be followed in the area in which the device is operated: 

  

 

High voltage! Danger to life! 

While the engine is running, the area around the ignition system especially 
holds the risk of danger due to high voltage. The following parts should 
therefore not be touched or removed unless explicitly stated otherwise: 

– Ignition coils and caps 

– Wires of the high voltage circuit 

– In- and output wiring of the ignition controller 

– Pickups and their wiring 

        

  

Danger to persons with pacemakers! 

Electromagnetic impulses in the wiring of the ignition system may exceed 
the permissible limits of pacemakers. Persons with pacemakers must 
therefore not be present in the vicinity of the ignition system being 
operated. Mark the operating location of the ignition system with the 
corresponding standardized warning symbol. 

  

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to 
operate. Nevertheless the equipment can cause risks or damages can occur, if the following 
instructions are not complied with: 

– The gas engine must only be operated by trained and authorized personnel. 

– Operate the equipment only within the parameters specified in the technical data. 

– Use the equipment correctly and for its intended use only. 

– Never apply force. 

– For all work, such as installation, conversion, adaptation, maintenance, and repair, all 
equipment must be disconnected from the power supply and secured against unintentional 
restarting. 

– Perform only such maintenance and repair work as is described in this operating manual, 
and follow the instructions given while working. For maintenance of the equipment, only use 
spare parts supplied by MOTORTECH. Further work must only be performed by personnel 
authorized by MOTORTECH. Non-compliance with the instructions will void any warranties 
for the proper function of the equipment as well as the responsibility for the validity of the 
certifications. 

– Safety devices must not be dismounted or disabled. 

– Avoid all activities that can impair the function of the equipment. 

2 SAFETY INSTRUCTIONS
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– Operate the equipment only while it is in proper condition. 

– Investigate all changes detected while operating the gas engine or ignition system. 

– Ensure compliance with all laws, directives and regulations applicable to the operation of 
your system, including such not expressly stated herein. 

– If the system is not entirely tight and sealed, gas may escape and lead to an explosion 
hazard. Upon completion of all assembly works, always check the system's tightness. 

– Always ensure adequate ventilation of the engine compartment. 

– Ensure a safe position at the gas engine. 
 

2.2  Electrostatic Discharge Hazards 
Electronic equipment is sensitive to static electricity. To protect these components from damage 
caused by static electricity, special precautions must be taken to minimize or prevent 
electrostatic discharge. 

Observe these safety precautions while you work with the equipment or in its vicinity. 

– Before performing maintenance or repair work, ensure that the static electricity inherent to 
your body is discharged. 

– Do not wear clothing made from synthetic materials to prevent static electricity from 
building up. Your clothing should therefore be made of cotton or cotton mix materials. 

– Keep plastics such as vinyl and Styrofoam materials as far away from the control system, the 
modules, and the work environment as possible. 

– Do not remove the circuit boards from the housing of the device. 
 

2.3  Special Safety Instructions for the Device 
   

 

Explosion hazard! 

Never remove the service screw or the service cover, unless the system is 
located in a non-explosive environment. 

     

 

Explosion hazard! 

The replacement of parts or assemblies can impair compliance with CSA 
Class I, Division 2 (Group C, D), T4. 
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Explosion hazard! 

When the system is powered up, do not remove any connectors unless the 
system is not located in a potentially explosive atmosphere. 

     

 

Explosion hazard! 

Never remove the equipment while the device is connected to a power 
source unless the system is not located in an explosive environment. 

     

 

Explosion hazard! 

Do not remove or replace the fuse while the equipment is live. 

     

 

Risk of burning! 

The surfaces of the system may heat up to high temperatures. 

     

 

Operational safety! 

All connector screws and screw joints must be adequately tightened. Refer 
to the section Mechanical Data on page 17.  

After the service cover on the device has been opened, e.g. to complete the 
wiring, it must be refitted so that it is in the same alignment as it was prior 
to opening. The USB-connection must always be below the service screw. If 
the mounting is rotated, maintaining the indicated protection classes, as 
well as compliance with CSA-Class I, Division 2 (Group C, D) is impaired. 
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Risk of damage! 

Magnetic fields and heat occur when welding, which may damage or 
destroy the MIC5. Therefore, pay attention to the following when welding: 

– Disconnect all electrical connections to the MIC5 prior to welding. 

– Protect the MIC5 against direct contact with the welding unit and 
magnetic fields, sparks and liquid metal. 

    
 

2.4  Proper Disposal 
After the expiration of its service life, MOTORTECH equipment can be disposed of with other 
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally 
friendly disposal. 
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3.1  Functional Description 
The devices of the MIC5 series are microprocessor controlled ignition systems, that are 
comprised of one 32 bit main processor (CPU) and an output board. 

Please note that the manufacturer is not required to implement configurations of the ignition 
controller for specific engines, and that devices may be delivered without pertinent 
configuration. 

The ignition controllers of the MIC5 series use information supplied by the pickups to precisely 
determine the correct timing for the respective outputs. The timing is influenced by various 
inputs made either automatically or manually. This can be implemented with manual 
potentiometers, the analog input signals, a speed characteristic, or with a serial interface (USB, 
CAN bus, RS485). 

During operation, the ignition controllers continuously monitor the system status of all installed 
pickups and the correct operation of the primary ignition circuit by checking the information 
received. 

Depending on the severity of an error that is detected, the device will shut down immediately or 
warn the operator. A corresponding message can be viewed on a connected PC. 

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off. 
 

3.2  Applications 
The ignition controllers of the MIC5 series are designed for specific 2- or 4-stroke gas engines 
depending on the type of device. From 1 to max. 20 ignition outputs are available. 

The ignition controllers supply the energy required for the corresponding ignition coils of the 
gas engines and can supply signals for peripheral equipment. 

Any use other than the one described in the operating manual shall be considered improper use 
and will result in the voiding of all warranties. 

 

3 INTENDED USE
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4.1  Technical Data 

4.1.1 Certifications 
The ignition controllers of the MIC5 series are certified as per the following 
directives/regulations: 

CSA 
Certification pursuant to CSA (Class I, Division 2, Group C, D, T4) is planned. 

ATEX 
Certification pursuant to ATEX (Zone 2, Category 3G, Gas group IIB, T3) is planned. 

CE 
– EMC Directive 

– Limits as per DIN EN 55011 (2007:11) 

– Emission standard for industrial environments as per DIN EN 61000-6-4 (2007:09) 

– Immunity for industrial environments as per DIN EN 61000-6-2 (2006:03) 

– Low Voltage Directive 
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 DECLARATION OF CONFORMITY 

The company: MOTORTECH GmbH
Hogrevestrasse 21-23 
29223 Celle 

declares that the products: MIC5 ignition controller

intended purpose: use with gas Otto engines

complies with the provisions of the following EC Directives: 

 EMC Directive 2004/108/EC (Group 1, 
Class A) 
Low Voltage Directive 2006/95/EC  

under consideration of the following standards:

 

DIN EN 55011:2011
DIN EN 61000-6-2:2006 
DIN EN 61000-6-4:2007 
DIN EN 60947-1:2007 

The marking of the product is: P/N 66.00.5xx-xx
 

 

This declaration is submitted by:

Name: Florian Virchow 
 

Position in company: Managing Director

  

  

  

Celle, dated 27.08.2013 

Place, date 
 

Legally binding signature 
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4.1.2 Mechanical Data 
The MIC5 has the following mechanical characteristics. 

Feature Value 

Dimensions 360,3 mm x 240 mm x 114.5 mm (14.19 '' x 9.45 '' x 4.51 '')
(length x width x height) 

Weight 8.2 kg (18.1 lbs)

Shape of device See chapter Overview Drawings on page 21. 

Mechanical environmental 
conditions 

The housing is resistant to general atmospheric 
contaminations. 

Resistant to gas engine lubricants. 

Protection class: 1 
Protection: IP65 

The specified protection classes and types are only 
guaranteed if the following tightening torques are 
maintained: 

– M4 screws: 0.8 to 1 Nm 

– PG screw joints 4.5 to 5 Nm 

– Service screws: 2.5 to 3 Nm 

Climatic environmental 
conditions 

Housing surface temperature: -40 °C to +60 °C (-40 °F to 
+140 °F) 

max. 85 % humidity without condensation 
up to 2000 m (6562 ') above sea level 

 
 

4.1.3 Warning Notices on the Device 
Text on the device 

WARNING! Read and understand the installation and operating manual prior 
to installing or making any adjustments. 

EXPLOSION HAZARD! Do not disconnect while circuit is live unless area is 
known to be non-hazardous. For wiring details please refer to operating 
manual. 

 
 
 

4.1.4 Product Identification – Labeling on the Device 
The necessary numbers for unique product identification are on the device: 
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– Product number of the ignition controller (P/N) 

– Arrangement number of the ignition controller (A/N) 

– Serial number of the ignition controller (S/N) 

 
 

4.1.5 Electrical Data 
The MIC5 has the following electrical characteristics. 

Feature Value 

Power consumption max. 240 W with 24 V

Power supply 16.8 up to 32 V DC

Required current Current max. 14 A. An estimation of the power requirements can 
be found in the table below. 

Number of outputs 20 outputs

Firing angle The size of the firing angle depends on the max. overspeed. The 
smallest firing angle per output bank can be calculated using the 
following formula: 

 

Ignition frequency With full energy output (all 20 ignition outputs with 500 mJ), an 
ignition frequency of 300 Hz as continuous load is possible. In 
the event of less ignition energy or in case of a brief overload, 
360 Hz is possible. The maximum output load of 180 W must not 
be exceeded. 

Output connector 35-pin military connector 
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Estimation of Current Requirements 
These current values are based on a nominal speed of 1800 rpm and 500 mJ energy 

Outputs Voltage Required current Voltage Required current 

10 24 V 5 A 16 V 7 A

16 24 V 7 A 16 V 11 A

20 24 V 9 A 16 V 14 A

  

Electrical Data for Inputs and Outputs 
The inputs and outputs of the ignition controller have the following electrical data:  

Inputs and outputs Values 

Analog current input Working resistance 27 Ω, damping 1 μF

Analog voltage input Working resistance 12.4 Ω, damping 200 nF

Aux. Analog Input Supply 
Voltage 

5 to 24 V / 50 mA depending on the configuration in the MICT

Digital Input (Start/Stop) Wiring

Input current: max. 20 mA 
Ignition stop: 0 to 0.8 V 
Ignition release: 2.8 to 32 V 

Digital Input (schedule A/B) Wiring

Input current: max. 20 mA 
Schedule A: 0 to 0.8 V 
Schedule B: 2.8 to 32 V 

Go/NoGo and GPO Outputs One GPO (General Purpose Output) and one Go/NoGo output

Implementation as optical MosFET 

Voltage applied: 7 to 32 V DC max. 

Peak/steady current: 100 mA DC max. 

Output: 2.5 W max. 

Internal resistance: 58 to 60 Ω 

Activation delay: 0.5 ms / 100 mA load max. 

Deactivation delay: 0.2 ms / 100 mA load max. 

If a short is found at the output, a safety circuit, which makes 
the output highly resistive, is found at the output, so that the 
current sets itself at 50 to 60 mA. 

Signal LED Six LEDs are used as status indicators.
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Inputs and outputs Values 

ASO Output TTL level (5 V)
max. current: ± 10 mA 

Pickup  
 Input 

Impedance: 10 kΩ

The voltage supply for active pickup can be set using the 
MICT from 5 to 24 V. 

Max. frequency for the pickups: 10 kHz 

The formula for determining the frequency of the pickups can 
be found in the note following this table. 

For a pickup output impedance of 120 Ω to 10 kΩ, the pickups 
connected to the MIC5 may not have a higher voltage than 
±40 V peak-peak and the connected power may not exceed 
1 Watt. 

Ignition Coil Outputs Output voltage: 250 V max.

Output energy: 500 mJ max. 

Boost mode: 630 mJ max. 

  

 

Frequency of the pickups 

The frequency of the pickup is calculated as per the following formula. 

 

  
 

4.1.6 Interfaces 
Depending on the device variant, the following interfaces are available: 

USB Interface 
– Compatible with USB 1.1 and higher 

– The connector type B  is suitable only for temporary data exchange and not for permanent 
connection. 

– Max. wire length 5 m (16,4 ') 

CAN bus 2.0B interface  
– As per ISO  11898 standard, 50 kBit/s to 1 MBit/s 

– Protected against transients (automotive classification) 

– Max. 110 participants  
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– Max. wire length 250 m (820 ') depending on the transfer rate 

RS485 Interface  
– According to TIA-485-A (03/2003) 

– Max. 32 participants 

– Max. data transfer rate 9.6 kBit/s to 115.2 kBit/s 

– Max. wire length 100 m (328 ') depending on the transfer rate 
 

4.1.7 Requirements for External Equipment 
External equipment shall fulfill the input and output specifications of the MIC5. 
 

4.1.8 Overview Drawings 
The drawings shown correspond to the standard MIC5 version with service cover. 

Devices without a service cover have an input connector at the front of the device. 
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Plan view 
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Front view 

 

LED functions 

 

 

LED functions 

Status LED flashes green when the device is running with no errors. If an error 
occurs, the LED is red, for a warning it is yellow. 

Firing LED lights up when the ignition is active.

PU 1 to 3 Flashing LEDs indicate activity of the pickups.

GPO LED is on when the GPO is activated. 
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Service screw 
A USB connection, a button, two potentiometers and the supply voltage connection* are located 
under the service screw. 

 

Labeling Function 

Power* Connection for the supply voltage (see Input Wiring – Power Supply on 
page 32)  

USB USB connection for connecting to the PC 

PB Buttons acknowledge errors, warnings and alarms or triggers a reset of 
the ignition controller. Please refer also to the notice below. 

A/B Potentiometer for the manual adjustment of the timing. The setting only 
has an effect if the potentiometer in the MICT is activated. 

* The connection for the supply voltage may be different depending on the device version. 
  

 

Behavior of the PB button 

With the  PB button on the device you can perform the following actions: 

– Press briefly (< 3 s): 
Existing warnings are acknowledged. 

– Press longer than 3 s: 
If no pickup signals are detected and an operating error exists, this will 
be acknowledged together with all alarms. Warnings are acknowledged 
in any case, even if no operating error exists. 

– Press longer than 15 s: 
If no pickup signals are detected, the ignition controller restarts.  
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5.1  Unpacking 
Unpack the equipment, taking care not to damage it, and ensure that the operating manual is 
always stored with the ignition controller and is easily accessible. Check the contents for 
completeness and verify that the device type meets your application requirements. 

Scope of Supply 
The scope of supply of the MIC5 ignition controller consists of the following components: 

– Ignition controller of the MIC5 series 

– Installation set incl. four vibration dampers 

– Ground strap 

– Three multiple sealing inserts and five sealing plugs for PG screw joints 

– CD-ROM with software for configuring the ignition controller 

– USB interface cable for connecting the ignition controller to a PC/laptop 

– Operating Manual 
 

5.2  Installation of the Ignition Controller 
The installation of the MIC5 ignition controller is implemented on a fixed bracket, e. g. on a wall 
near the engine. Use the included vibration dampers and the ground strap. The installation 
location of the controller must be selected so that the distance to the pickups installed on the 
engine ensures a reliable signal transmission to the ignition controller, and so that there is 
adequate space for maintenance and repair work. The mechanical specifications must always be 
complied with (refer to Mechanical Data on page 17). The ground strap serves to ground the 
ignition controller and must be used accordingly. Ensure a flawless electrical connection for this 
purpose. 

Installation locations where strong vibrations or extreme ambient temperatures are present are 
not permissible and result in the warranty being voided. The permitted temperature range is -
40 °C (-40 °F) to +60 °C (+140 °F). To ensure sufficient cooling through the cooling body, the 
device must be mounted so that the vanes of the cooling body are vertical and the hot air can 
escape upwards unimpeded. 

  

 

Risk of damage! 

The device must not be installed directly on or at the engine, as vibration 
and heat may cause damage to electronic components. 
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5.3  Determine the Installation Location of the Pickup 
Set the positions of the pickups depending on engine type and application. All angle reference 
information is based on: 

TDC 1st cylinder /Compression cycle 

The installation location for the pickups must have adequate mechanical strength and must not 
exceed the specified temperature ranges. The pickups are designed for the appropriate use 
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate 
the calibration of the sensor. Comply with the pertinent regulations for the wire routing. 

For the exact positioning of the individual pickups, refer to the examples given in the drawings 
(see section Input Wiring – Pickups on page 33). 
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6.1  Input and Output Wiring on the Controller 
  

 

Operational safety! 

All connector screws and screw joints must be adequately tightened. Refer 
to the section Mechanical Data on page 17.  

After the service cover on the device has been opened, e.g. to complete the 
wiring, it must be refitted so that it is in the same alignment as it was prior 
to opening. The USB-connection must always be below the service screw. If 
the mounting is rotated, maintaining the indicated protection classes, as 
well as compliance with CSA-Class I, Division 2 (Group C, D) is impaired. 

    

 

Operational safety! 

Improper wiring using the PG screw joints impairs the compliance with the 
specified protection classes as well as with CSA Class I, Division 2 (Group C, 
D). Please adhere to the following points: 

– Do not pass any cables without matching sealing inserts through the PG 
screw joints. 

– A sealing insert must be used in every PG screw joint. 

– Unused bore holes for the sealing inserts must be sealed using sealing 
plugs. 

– The PG screw joints must be adequately tightened. 

For additional information on PG screw joints and sealing inserts please 
refer to Mechanical Data on page 17. 

   

 

Assignment of the wire colors 

Take the assignment of the wire colors of the wiring harness for the input 
and output wiring from the wiring plan enclosed with the wiring harness. 

  
The wiring to the connector strip is fed through the PG screw joints at the device front (standard 
version). 
 

6.1.1 Input cabling 
For the standard MIC5 version, the connections for the input wiring are located on the connector 
strip below the service cover. For device versions without a service cover, the input wiring is 
established using a 35-pole input connector at the device front. 

6 WIRING OF THE DEVICE
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Functions and connector strips under the service screw and service cover 

 

Designation Function 

     Connections and
      functions under the 
      service screw

 

Power Connection for the supply voltage (see Input Wiring – Power 
Supply on page 32)  

USB USB connection for connecting to the PC

PB Buttons acknowledge errors, warnings and alarms or triggers a 
reset of the ignition controller. 

A/B Potentiometer for the manual adjustment of the timing. The 
setting only has an effect if the potentiometer in the MICT is 
activated. 

Pickup Connection for the pickups (see Input Wiring – Pickups on page 
33) 

CAN CAN interface for connecting external equipment (see Output 
Wiring – CAN Bus – Interface on page 41) 

Digital Output Connection for digital outputs (refer to Output Wiring – Digital 
Outputs (Go/NoGo, GPO, ASO) on page 37) 

RS485 RS485 interface for connecting external equipment (see Output 
Wiring – RS485 Interface on page 42) 

Analog/Digital Input Connection for timing & safety devices (see Input Wiring – Timing 
and Safety Devices on page 35)  

 
The wiring to the connector strips is fed through the PG screw joints at the device front. 
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35-pole input connector 

 

35-pole input connector (outside view) 

Assignment of the connections 
The table contains the connection assignment of different MIC5 versions. The wiring examples 
contained in this operating manual refer to devices with a service cover and connector strip. 
 

Connection 
designation 

Connection no. on the connector 
strip 

 35-pole 
connector 
 
 

Ground Power 1 B

16,8-32 V  2 A

PU1 Power Pickup 1 C

PU1 Signal  2 D

PU1 Com  3 E

PU1 Shield  4 F

PU2 Power  5 G

PU2 Signal  6 H

PU2 Com  7 J

PU2 Shield  8 K

PU3 Power  9 -
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Connection 
designation 

Connection no. on the connector 
strip 

 35-pole 
connector 
 
 

PU3 Signal  10 -

PU3 Com  11 -

PU3 Shield  12 -

CAN Display High CAN 1 -

CAN Display GND  2 -

CAN Display Low  3 -

CAN Display Shield  4 -

CAN High  5 L

CAN GND  6 M

CAN Low  7 N

CAN Shield  8 P

Go/NoGo High Digital
Output 

1 R

Go/NoGo Low 2 S

GPO High  3 T

GPO Low  4 U

ASO Out  5 V

ASO GND  6 W

ASO Shield  7 X

U In + Analog/
Digital 
Input 

1 -

Analog GND 2 d

Analog PWR 3 e

I In -  4 f

I In +  5 g

Analog Shield  6 h
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Connection 
designation 

Connection no. on the connector 
strip 

 35-pole 
connector 
 
 

Start/Stop In  7 j

Schedule A/B In  8 k

GPI1  9 l

Digital GND  10 m

Shield  11 -

Tx High RS485 1 Y

Tx Low  2 Z

GND  3 a

Rx High  4 b

Rx Low  5 c

Shield  6 -
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6.1.2 Input Wiring – Power Supply 
 

 

 

Variations 

1 Battery Generator Control Unit

 

2  Supply Voltage

 

3  Battery Charger

 

  
  
 



 
 

Rev. 04/2014 33 

6.1.3 Input Wiring – Pickups 
Example Configuration (One Active, Two Passive Pickups) 
  

  

Camshaft 

Crankshaft  
(Reset) 

Crankshaft 

  

Allocation of the Wire Colors (Example Configuration) 
Camshaft 

Pin Designation Wire color 

1 PU 1 Power brown

2 PU 1 Signal black
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Pin Designation Wire color 

3 PU1 Com blue

4 Shield shield

  
Crankshaft (Reset) 

Pin Designation Wire color 

6 PU 2 Signal Flywheel with pin

white 

Flywheel with hole

brown 

7 PU 2 Com Flywheel with pin

brown 

Flywheel with hole

white 

8 Shield shield

  
Crankshaft 

Pin Designation Wire color 

10 PU 3 Signal white

11 PU 3 Com brown

12 Shield shield

  

For problems with the pickup signal, refer to the section Pickup Input Errors on page 141. 

  

 

Adjusting the pickup sensitivity 

Depending on the type of impulse source (interference), it may be necessary 
to increase the pickup sensitivity to ensure that the resultant signal 
strength is sufficient for reliable operation. You can make these 
adjustments in the MICT. Refer to the section Engine – Pickups on page 82. 

   

 

Aux. pickup supply voltage 

An auxiliary supply voltage for active pickups can be configured using the 
MICT. The voltage can be set in the range from 5 to 24 V and is supplied on 
the connections PU1 Power to PU3 Power. Refer to the section Engine – 
Pickups on page 82. 
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6.1.4 Input Wiring – Timing and Safety Devices 
Example configuration 

*) For details, see Subsequent Drawings

 
x = bridge for permanent authorization 
(must be removed for external ignition 
authorization) 
  

Switch Start/Stop 

open Ignition - OFF

closed Ignition - ON

Switch A/B 

open Schedule A

closed Schedule B

Switch GPI1 

1 sec. Reset CAN driver

5 sec. Reset MIC5

 
 



6 WIRING OF THE DEVICE 
 

36 Rev. 04/2014 

Two-wire transmitter 

 

Four-wire transmitter 

 

   

 

Aux. analog input supply voltage 

An auxiliary supply voltage for the analog inputs can be configured using 
the MICT. The voltage can be set in the range of 5 to 24 V and is made 
available on the connection Analog PWR. If using current transmitters 
analog PWR is used for loop PWR and analog GND is used for sensor GND. 
Please refer to the section Timing – Analog Inputs on page 86. 
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6.1.5 Output Wiring – Digital Outputs (Go/NoGo, GPO, ASO) 
Example configuration 

 

 

 

*) DetCon or other external device (for 
wiring of the DetCon, see following 
example) 

K1 = Go/NoGo relay 

K2 = GPO relay  

L ≙ 7 to 32 V DC 

 

(L ≙ 7 to 32 V DC)  
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DetCon connection 

Connect the ASO output on the DetCon on the connections Timing 1 and 
Timing 2 on connector Ignition Pulse. 
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6.1.6 Wiring – PowerView3 
Connect the PowerView3 visualization unit to the MIC5 as follows. 

CAN Connection between Ignition Controller and PowerView3 
As shown in the following illustration, you can connect the PowerView3 directly to the 
MOTORTECH ignition controller using the CAN cable delivered with the PowerView3. To do so, 
you need to insert the connector in the CAN interface on the PowerView3. On the ignition 
controller, connect the color-coded conductors of the CAN cable to the correct CAN interface 
connections. 

 

 

Connector for CAN 
interface on PowerView3 

  
 
 
 
 
 
 
 
 
 
 
CAN interface on the 
ignition controller 

PowerView3 power supply via the ignition controller 
If you use a MOTORTECH ignition controller with a service cover and connector strip, you have 
the option of supplying power to the PowerView3 via the ignition controller. A special connector 
is included in the PowerView3's scope of supply. This must be replaced for the connector for the 
power supply from the ignition controller's scope of supply. 
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Connector supplied with 
the ignition controller 

Connector supplied with
PowerView3 * 

  

* A cable is already attached to this connector, the other end of which is connected to the 
PowerView3. 

 
1. Disconnect the ignition controller's power supply. 

2. Remove the connector for the power supply from the ignition controller. 

3. Positive terminal: Disconnect the conductor from the contact  and insert it into the 
contact  of the connector included with the PowerView3. 

4. Negative terminal: Disconnect the conductor from the contact  and insert it into the 
contact  of the connector included with the PowerView3. 

5. Connect the device's power supply. 

▸ The power supply of the PowerView 3 now branches off from the connector for the 
ignition controller. 
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6.1.7 Output Wiring – CAN Bus – Interface 
The product must be connected to a CAN bus as follows: 

  First device Second-to-last device

 

   Second device Last device

Notice: The CAN-Bus connectors 1-4 are currently unavailable.

  

 

CANopen protocol 

If you require information on the CANopen protocol, please contact your 
MOTORTECH contact person. 

   

 

CAN bus wiring 

Note the following when connecting the CAN bus: 

– There can be a maximum of 110 devices connected to one CAN bus. 

– The maximum wire length is 250 m (820 ') depending on the transfer 
rate. 

– Each bus end must be fitted with a terminating resistor of 120 Ω (see 
drawing). 
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6.1.8 Output Wiring – RS485 Interface 
The RS485 interface can be wired as two-wire or four-wire wiring and twisted cables must be 
used. With both variants the load resistance (RT=120 Ω) is the characteristic impedance of the 
cable. 

Two-Wire Wiring 
 
First device   Last device

 

 Second device Second-to-last device

Four-Wire Wiring 
 
First device 
(Master) 

  Last device
(Slave) 

 

 Second device
(Slave) 

Second-to-last 
device 
(Slave) 

 



 
 

Rev. 04/2014 43 

Connection on the Ignition Controller 
The RS485 interface is wired using the 6-pin plug. 

 

  

 

Wiring of the RS485 interface 

Follow these instructions for the RS485 interface wiring: 

– Max. 32 devices can be connected to a bus. 

– The maximum wire length is 100 m (328 ') depending on the transfer 
rate. 

– Each bus end must be fitted with a terminating resistor with 120 Ω (as 
indicated in the drawing). 
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6.2  Ignition Coil Wiring 
  

 

Ignition coil wiring 

In the MICT there are two types of wiring with predefined output 
configuration supported in the engine database for many engines: 

– wired in straight order 

– wired in firing order 

For information on straight order wiring refer to Straight Order Wiring of the 
Ignition Outputs on page 46 and Engine – Parameters on page 74. 

For wiring in firing order, the first cylinder in the firing order is connected to 
the A1 output, the second to B1 (A2 for an output board), etc.  

If a different wiring was implemented, the output configuration in the MICT 
must be adapted accordingly. Please note that the wiring cannot be 
checked by the software (refer to Engine – Parameters on page 74). 

  
 

6.2.1 Ignition Coil Wiring for a 35-Pole Connector 
The table shows the pole assignments for the output connector. 

 

35-pole output connector (outside view) 
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Pin Output    Pin Output 

A Output A1 L Output A6

B Output B1 M Output B6

C Output A2 N Output A7

D Output B2 P Output B7

E Output A3 R Output A8

F Output B3 S Output B8

G Output A4 T Output A9

H Output B4 U Output B9

J Output A5 V Output A10

K Output B5 W Output B10

m Ground   

 
 

6.2.2 Ignition Coil Wiring 17-Pole and 14-Pole Connector 
The table shows the pole assignments for the output connector. 

 

17-pole output connector and 14-pole output connector (Outside view) 
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Pin Output (17-pole) Pin Output (14-pole) 

A Output A1 A Output B1

B Output A2 B Output B2

C Output A3 C Output B3

D Output A4 D Output B4

E Output A5 E Output B5

F Output A6 F Output B6

G Output A7 G Output B7

H Output A8 H Output B8

J Output A9 I Output B9

K Output A10 J Output B10

N Ground N Ground

  
 

6.2.3 Straight Order Wiring of the Ignition Outputs 
  

 

Risk of damage to engine 

If you use straight order wiring, it is absolutely necessary that the 
MOTORTECH wiring rail for the respective engine is used and correctly 
installed. Even a rotated installation can cause serious damage to the 
engine, for example. 

  
Straight order wiring, along with wiring in firing order, is supported by the MICT for many 
engines with predefined output configurations in the engine database. That means that if the 
wiring is carried out accordingly and the option Wired in Straight Order is selected in the MICT, 
no other adaptation of the output configuration is necessary. 

You can use straight order wiring, if: 

– Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH 
AlphaRail. The harness is marked with the following information: CAUTION! The firing order 
needs to be configured directly in the ignition controller. The ignition coils on the wiring rail 
are marked with Connector Pin 1 to Connector Pin X. 

– Make the wiring of the ignition controller corresponding to the instructions in the following 
sections (for example with an open wiring harness or via a junction box). 

Execution of straight order wiring is dependent on the following factors: 

– one or two output banks in the ignition controller 

– the type of engine (in-line or V engine). 
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– Alignment of the wiring rail(s) 
 

6.2.4 Straight Order Wiring of the Ignition Outputs – Overview 
The table contains the allocation of the MIC5 outputs to the cylinders. 

Output In-line engine V engine 

Output A1 S1 Sp1 S1 Sp1

Output B1 S1 Sp2 S2 Sp1

Output A2 S1 Sp3 S1 Sp2

Output B2 S1 Sp4 S2 Sp2

Output A3 S1 Sp5 S1 Sp3

Output B3 S1 Sp6 S2 Sp3

Output A4 S1 Sp7 S1 Sp4

Output B4 S1 Sp8 S2 Sp4

Output A5 S1 Sp9 S1 Sp5

Output B5 S1 Sp10 S2 Sp5

Output A6 S1 Sp11 S1 Sp6

Output B6 S1 Sp12 S2 Sp6

Output A7 S1 Sp13 S1 Sp7

Output B7 S1 Sp14 S2 Sp7

Output A8 S1 Sp15 S1 Sp8

Output B8 S1 Sp16 S 2 Sp8

Output A9 S1 Sp17 S1 Sp9

Output B9 S1 Sp18 S2 Sp9

Output A10 S1 Sp19 S1 Sp10

Output B10 S1 Sp20 S2 Sp10

Ground   

  
S = connector on the wiring rail 
Sp = ignition coil with the corresponding number on the wiring rail 
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The ignition controllers of the MIC5 series include freely configurable safety and auxiliary 
functions that, amongst others, can shut down the engine in case of fault. 

  

 

Angle indications in the operating manual 

All angles in this operating manual are given in °crankshaft. Exceptions are 
clearly identified. 

  
 

7.1  Pickup Sensitivity 
To increase the signal interference distance, the sensitivity of the pickup signal inputs can be 
changed for suitable pickup signals. This setting can be implemented individually for each 
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as 
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus 
result in a low pickup sensitivity level. 

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine – 
Pickups on page 82. 
 

7.2  Monitoring of Pickup Signals 
The MIC5 monitors the pickup signals. Any other errors are displayed in the MICT. For further 
information on errors, please refer to the overview in section Causes of typical errors on page 
141. 
 

7.3  Go/NoGo 
The MosFET output (Go/NoGo) is a potential-free output. It is closed during firing and opens 
when the ignition switches off. The maximum switching current is 100 mA. The output can drive 
an external relay that, for example, opens a gas valve. 

The following errors can cause the ignition outputs to shut down: 

– Overspeed 

– Pickup error 

– Error HV power supply 

– Failure of the output monitoring 

– Overload / temperature shut-down 

– Alarms 

– Insufficient supply voltage (Low Power) 
 

7 FUNCTIONS 
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7.4  Timing Correction 
The ignition controller has several functions for the timing correction. 

  

 

Influencing the ignition timing 

Please be aware that the actual timing of the engine can also be influenced 
by external signals (e. g., analog current or voltage input). 

   

 

Operational safety 

The MIC5 ignition controller must first be correctly configured for the engine 
being used before you can start the engine. 

An incorrect configuration can result in damage to the engine. 

  

The figure below gives you an overview of the different functions of the timing correction, which 
will be explained in more detail in the subsequent sections. Functions that can be 
activated/disabled via the MICT are marked by a switch symbol. 
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 Per schedule:     
 Base timing 

 

  
 Speed curve 

  
 Analog voltage input 

  
 Analog current input 

  
 Potentiometer 

  
 Global: 

 Ignition timing correction 

    
 Per cylinder:   
 Cylinder individual 

offset 

 

 Limited by the 
min./max. cylinder 
individual offset 

    

    Limited by the 
min./max. ignition 
timing 

 
 

7.4.1 Manual Timing Correction 
The ignition controllers of the MIC5 series include two permanently installed overwind-protected 
potentiometers for manually correcting the timing point. The max. range is defined with the 
corresponding limits that are set by the user. Potentiometer A controls the ignition timing for 
schedule A and potentiometer B controls the ignition timing for schedule B. 
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7.4.2 Analog Inputs 
The timing point control can be adjusted with a linear current signal. This signal can be 
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a 
detonation controller. 

With the analog process signal (current loop signal) at the analog current input, the timing point 
can be offset in the advanced or retarded direction within a defined range. 

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the 
corresponding input. 

The levels of the analog inputs can be set in the range from 0 to 20 mA and 0 to 10 V. You can 
make this configuration with the MICT. Please refer to the section Timing – Analog Inputs on 
page 86. 

At the voltage output (Analog PWR), a configurable auxiliary voltage is supplied that can be used 
for supplying power to external sensors. 
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Sample configurations 

In this example the analog inputs are configured in the Timing – Analog 
Inputs window as follows: 

– Input current: 4-20 mA 

– Input voltage: 0-5 V 

Characteristic 4-20 mA / 0-5 V – Timing correction toward retarded. 

 

Characteristic 4-20 mA / 0-5 V – Timing correction toward advanced. 

 

  
 

7.4.3 Cylinder-to-Cylinder Alignment 
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders 
to optimize their combustion. 

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to 
the section Cylinder Individual Offsets on page 128. 
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Use of measuring unit 

Use this setup option only if no suitable measuring unit is available for 
determining the optimum timing point, so that the result of a change can be 
assessed immediately. 

  
 

7.4.4 Speed Curve 
To optimize the ignition, for example, during the start phase of the engine, a speed curve can be 
defined for the MIC5 ignition controllers. To create this curve, up to eight adjustable speed 
points are available. 

You can configure the speed curve with the MICT. Refer to the section Timing – Schedule A/B – 
General on page 88. 
 

7.4.5 Timing Correction 
There are two options for making corrections to the ignition timing: 

– CANopen/Modbus/J1939 
The field buses can be used to adjust the cylinder individual ignition timing points in 0.1° 
increments by max. +/- 12.5° crankshaft, restricted by the ignition timing point limits of the 
current schedule. 

– MICT via USB 
Please refer to the section Runtime Adjustments – Timing on page 124. 

 

7.5  Firing angle 
The min. distance between two ignition angles depends on the overspeed. The smallest ignition 
spacing per output bank can be calculated using the following formula: 

  
 

7.6  HV-Power Supply Error Monitoring 
The voltage applied is monitored for excess voltage or low voltage by the integrated power 
supply. For both errors a Power-Fail error is saved and the device shuts off. 
 

7.7  Schedules A/B 
The MIC5 ignition controllers offer two separate schedules for the parameterization of the 
ignition timing and energy. 

By closing input Schedule A/B , the listed parameter settings for schedule B can be selected. A 
possible application for this is e. g. operation with different gases. If only one schedule is 
configured, this is used regardless of the switch position. 
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You can configure the schedules with the MICT. Please refer to Timing – Schedule A/B – General 
on page 88 and Timing – Schedule A/B – Energy on page 90. 

  

 

Operational Safety 

If you use schedules A and B, the advanced timing point should be linked to 
schedule B (switch closure). If a wire ruptures, schedule A is automatically 
selected with the retarded (and thus safer) timing point. 

  
 

7.8  Alarms 
The MIC5 ignition controllers include 16 freely configurable alarms in total. These alarms can be 
freely allocated to the general purpose output (GPO) and set depending on the following 
functions: 

– Limit for speed exceeded / not reached 

– Limit for engine operating hours exceeded / not reached 

– Limit for spark plug operating hours exceeded / not reached 

– Warning active 

– Error active 

– Limit for temperature exceeded / not reached 

– Limit for supply voltage exceeded / not reached 

– Limit for global ignition timing exceeded / not reached 

– Limit on the analog voltage input exceeded / not reached 

– Limit on the analog current input exceeded / not reached 

– Limit of the minimum spark duration exceeded / not reached 

– Misfire rate (primary, single output) over limit 

– Misfire rate (primary, all outputs) over limit 

– Misfires per second (primary, all outputs) over limit 

– Consecutive misfires (primary, single output) over limit 

– Misfire rate (secondary, single output) over limit 

– Misfire rate (secondary, all outputs) over limit 

– Misfires per second (secondary, all outputs) over limit 

– Consecutive misfires (secondary, single output) over limit 

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer 
to the section Inputs/Outputs – Alarms on page 92. 
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7.9  GPO: General Purpose Output 
The function of the general purpose output (GPO) can be set as desired as normally closed or 
normally open. The GPO can be used for the freely definable alarms. 

You can enter the settings for the general purpose output with the MICT. Refer to the section 
Inputs/Outputs – Alarms on page 92. 
 

7.10  ASO: Auxiliary Synchronization Output 
The ASO is an output of the MIC5 for synchronizing the MIC5 ignition controller and a connected 
control unit. The possible applications include detonation control, valve control, and fuel 
injection control. 

The ASO signal is Low-Active, i. e. the pulse width is defined as the time difference between the 
raising and falling edge (pulse width = traising – tfalling). The raising edge of the signal marks the 
configured engine rotation angle. With the variable pulse width, the values can be allocated to 
the engine rotation angle. A max. of 20 pulses can be configured for this purpose. 

The pulse width is known at the time of the active edge, as the falling edge of the signal 
precedes the raising edge by the value of the pulse width. The controller calculates the duration 
of the falling edge from high-level to low-level and then back to the starting value of the high-
level. 

You can configure the auxiliary synchronization output with the MICT. Refer to the section 
Inputs/Outputs – ASO1 (auxiliary synchronization output) on page 94. 
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Application of the ASO signal 

The following example will illustrate the application of the ASO signal: 

– Four-stroke engine with 6 cylinders 

– Ignition angle 120° - 120° 

Synchronization between MIC5 and Valve Controller 

Cyl. Ignition angle in 
°crankshaft 

ASO signal in 
°crankshaft 

Pulse duration in 
μs 

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

 

Schematic Representation 

 

*) active edge 

The valve controller should receive the active edge of the ASO signal before 
the top dead center of a cylinder. The first pulse duration should be twice 
as long and thus mark the beginning of a cycle. The ASO signal generated 
by the MIC5 increases by 2° each time before the ignition signal from Low 
to High, as can be seen in the schematic drawing. This edge is analyzed by 
the valve controller as the active edge. 

The ASO signal drops in accordance with the configured pulse duration 
from High to Low before the active edge. The valve controller then has 
already measured the pulse duration of the active edge and can provide 
information on the allocation of the signal. In the example shown here, the 
first cylinder is marked with a pulse width of 160 μs versus 80 μs for other 
cylinders. If the valve controller measures a pulse width of 160 μs, the 
subsequent signal is therefore allocated to the first cylinder. The next 
signal then corresponds with the second cylinder in the ignition sequence, 
etc. 
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7.11  Ignition Energy 
The ignition energy can be set separately for the start phase and normal operation. Here 
different settings can be made for schedules A and B. 

You can configure the ignition energy with the MICT. Refer to the section Timing – Schedule A/B 
– Energy on page 90.  
 

7.12  Access Control 
The MIC5 has four operating levels, three of which can be secured with different PINs. As a 
default setting, the access control is not activated. If the access control for the MIC5 is activated, 
it is independent from the access levels that control authorizations within the MICT.  

  

 

Access control in the MICT and on the MIC5 

A user is logged in to the Advanced Service access level on the MICT. He 
changes a configuration and would like to download the change to the 
MIC5. Although he has the full authorization set in the MICT, he is prompted 
to log in with the PIN for the Level 3 (Master) on the MIC5. 

  
A variety of functions are at your disposal in the four MIC5 operating levels. The figure below 
illustrates this: 
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The following functions are available on the different levels: 

– Level 0 (Read Only) 
Enables read only access for all users. 

– Level 1 (Operator) 
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on 
this level. 

– Level 2 (Service) 
Only the Service level has access to modifications of the runtime adjustments for Timing and 
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual 
Offsets and the Settings for Self Test can also be executed in this operating level. 

– Level 3 (Master) 
On this level, the Master can, in addition to the other adjustments, modify the Reset Position 
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to 
transfer a configuration to an ignition controller. 

For information on the access levels in the MICT, please refer to the section Access Levels in the 
MICT on page 60. 
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MICT is an abbreviation for MOTORTECH Ignition Configuration Tool. With the MICT, you can 
configure your ignition controller, and you can view and adjust the operating data of your 
engine. 
 

8.1  MICT System Requirements 
For the installation of the MICT, the following minimum requirements must be fulfilled: 

– x86-compatible PC, minimum performance category Intel Pentium 4 with 2 GHz 

– 128 MB free RAM 

– 100 MB free disk space 

– USB interface 1.1 or higher 

– Display with minimum XGA resolution (1024 x 786 pixels) 

– Microsoft Windows XP, Windows 7 
 

8.2  MICT Installation 
The software for the installation of the MICT is on the CD-ROM enclosed with the ignition 
controller. 

To install the MICT, proceed as follows:  

1. Start the installation. 

– CD-ROM as installation medium 
Insert the CD-ROM in the CD/DVD drive of your PC. If the Autorun function is activated for 
the drive, the installation will start automatically. If the function is disabled for the 
drive, the installation routine can be started with the file setup.exe from the CD-ROM 
directory. 

– Alternative 
Copy the installation routine setup.exe to your PC. The installation is started by 
executing the file. 

2. Run the installation. 
Follow the instructions of the installation routine. Please note that the license agreement 
terms must be accepted before using the MICT. If the terms are not accepted, the installation 
cannot continue. 

3. Install the USB driver by running the file CDMxxxxx_Setup.exe (e.g. CDM20824_Setup.exe). 

▸ The MICT is now set up. You can connect your PC to the ignition controller via the USB 
interface. 

 

8 SETTINGS VIA THE MICT
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8.3  Access Levels in the MICT 
You can open the MICT via Start -> Programs -> MOTORTECH -> MICT -> MICT on your PC. 

After opening the MICT, select the access level for which you have clearance. The access level 
controls the options you have at your disposal in the MICT. The password required for access 
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on 
page 144). 

 

The following access levels are available: 

– Read Only 
On this level, the user can open a configuration and transfer it to the device. However, he 
cannot make changes to the configuration. The user has read-only access to all other 
settings. 

– Customer 
This level enables the configuration of the basic functions required for operation in addition 
to the read-only function. 

– Service 
This level contains all functions for a standard installation. 

– Advanced Service 
This level offers full access to all functions of the MICT and is enabled and accessible for 
specially trained personnel only. 

The following sections will describe the options at your disposal with the Advanced Service 
access level. If you have registered for a different level, you cannot execute all functions shown. 
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8.4  Configuration Pages (Overview) 
The configuration pages are divided into the following sections: 

 

 

Item no. Area 

 Menu Bar

 Toolbar 

 Navigation bar

 Configuration section

 Status bar

 
The functions in the menu bar, navigation bar and the toolbar as well as the configuration 
section will be described in the following. 

The status bar provides you with the following information (from left to right): 

– Status Display 
Indicates whether a connection is established with the controller: 

– Green: Connection established 

– Red: The connection was interrupted and is being restored 
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– Gray: The connection is not established and is not being restored 

– Indication of the interface being used for the connection to the device 

– Indication of the device ID 

– Indication of the access level of the user in the MICT 

– Indication of the operating level for the MIC5 if the access control feature was activated and 
the user has logged in with a PIN 

– Indication of the MICT program version 
 

8.5  Menu Bar and Toolbar 
The following functions are available to you via the symbols on the toolbar and the entries in the 
menu bar: 

Symbol Menu Function 

 

File -> New Creates a new configuration.

 

File -> Open Opens an existing configuration.

 

File -> Save / 
File -> Save As 

Saves the current configuration.

 File -> Close Closes the current configuration.

 File -> Open trace Opens a runtime data record (trace file). 
Please refer to the section Runtime Data on 
page 99. 

 File -> Open pickup trace Opens a saved record of pickup signals 
(putrace file). Refer to the section Pickup Trace 
on page 67. 

 

File -> Change Access Level Changes the MICT access level for accessing 
the configuration data and functions. 

 

File -> Print Prints the current configuration.

 

File -> Print to PDF File Prints the configuration to a PDF file.
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Symbol Menu Function 

 File -> Print Preview Opens a print preview of the configuration.

 File -> Quit Exits the MICT.

 

Device -> Connect Connects to the device.

 

Device -> Disconnect Cuts the connection to the device.

 

Device -> Download to device Downloads configuration data from the PC to 
the device. Refer to Working with 
Configurations on page 71. 

 

Device-> Upload from Device Uploads configuration data from the device to 
the PC. Refer to Working with Configurations 
on page 71. 

 

Device -> Runtime data Opens the window Runtime data. Please refer 
to the section Runtime Data on page 99. 

 

Device -> Log Opens the window Log (Advanced Service
only). Please refer to the section Log on page 
122. 

 

Device -> Runtime adjustments Opens the window Runtime Adjustments
(Service and Advanced Service only). Please 
refer to the section Runtime Adjustments on 
page 123. 

 

Device -> Cylinder individual 
offsets 

Opens the window Cylinder Individual Offsets 
(Advanced Service only). Please refer to the 
chapter Cylinder Individual Offsets on page 
128. 

 Device -> Self test Opens the window Self Test (Service and 
Advanced Service only). For this read section 
Self Test on page 66. 

 Device -> Pickup trace  Loads the automatically recorded pickup 
signals from the device. Refer to the section 
Pickup Trace on page 67. 

 Device-> Set spark plug operating 
hours 

Opens the window Set spark plug operating 
hours. 



8 SETTINGS VIA THE MICT 
 

64 Rev. 04/2014 

Symbol Menu Function 

 Device -> Set engine operating 
hours 

Opens the window Set engine operating hours.

 Device -> Set date and time Opens the window Set date and time, in which 
you can set the clock in the device. 

 Device -> Send command -> Reset 
misfire counters 

The misfire counters of all ignition controller 
outputs are reset and restarted. Misfires that 
previously occurred at the outputs are no 
longer displayed. 

 Device -> Send command -> 
acknowledge operational errors 

All operating errors are acknowledged. This 
can only be implemented while the engine is 
not running.  

 Device -> Access Control The setup for the access controls for the MIC5 
are described in a separate section. Please 
read the chapter Access Control for the MIC5 
on page 69. 

 Device -> Temperature Extremes Opens the Temperature Extremes window in 
which the minimum and maximum 
temperatures of the controller and output 
boards are displayed. 

 Settings -> Language Opens the window Select Language in which 
you can change the interface language of the 
MICT. 

 Settings -> Online update settings Opens the window Online Update Settings. 
Please refer to the section Online Update 
Settings on page 65. 

 Settings -> Temperature scale Opens the window Select Temperature Scale, 
in which you can change the unit for the 
temperatures shown in the MICT. 

 Settings -> Display by cylinders Currently not used. 

 

Document -> Schedule Curve Opens the window Schedule Curve. Please 
refer to the chapter Schedule Curve on page 
129. 

 Tools -> Coils Opens a database with information on 
MOTORTECH ignition coils. 

 Help -> Help Opens the online help function.
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Symbol Menu Function 

 Help -> About MICT Opens detailed information on the MICT.

  
 

8.6  Online Update Settings 
  

 

Perform regular online updates 

MOTORTECH is constantly expanding its databases. Perform regular online 
updates to make optimal use of the opportunities that the MIC5 provides. 

  

The MICT uses data from an engine database and a coil database for the configuration. Such 
data can be updated with automatic online updates. The settings for the update can be entered 
with the following entry in the menu bar: 

Settings -> Online update settings 

 

You have the following options: 

– Enable automatic online updates 
Use the checkbox to activate and disable the automatic online updates. As the default 
setting, the online update is activated and is executed daily (if an internet connection is 
established) at first start-up of the MICT. 

– Use a proxy to access the web 
Using the checkbox, you can activate settings for Internet access via a proxy server, which 
you can then set up by entering http Proxy and Port. 

– Show Log 
Use this button to open a window in which the online updates performed are logged. 

– Update Now 
Use this button to manually start an online update. 
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8.7  Self Test 
  

 

Operational safety! 

If you carry out a self-test, it is essential for the gas supply to be switched 
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons. 

  

You can run the self test via the MICT to check the order of the wiring and the connection 
between the ignition controller outputs and the spark plugs. 

Proceed in the MICT as follows: 

Device -> Self Test 

 

The following information is provided: 

Status 
The status displays indicate whether the ignition controller is ready for the self test. 

Locked The ignition controller is in a state in which no self test can be done. For example, there 
is an error or a configuration is currently being downloaded into the device. 

– Active 
The self test is running. 

– Ready 
The ignition controller is ready and the self test can be started. 

You have the following options: 

– Cycles 
Specify whether the number of cycles is unlimited or set at a specific number. 
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– Outputs 
Specify whether all outputs or only a defined output should be fired during the self test. 

– Cycle Time - All Configured Outputs 
Specify the cycle time either as a period or frequency. The value entered always refers to a 
complete cycle. That means that all outputs that are configured are fires once per cycle. If 
you only set one output for the self test, this would still only fire once per cycle. 

– Control 
Start or stop a self test using the corresponding buttons. 

 

8.8  Pickup Trace 
The traces of the pickup signals support you in checking the behavior of the used pickup and 
thus, for example, to detect and analyze irregularities or failures. 

Pickup signals are automatically recorded by the ignition controller as soon as they are detected 
at the configured inputs. Ten further signals are recorded if an error occurs during operation 
(cumulative across all inputs). The recording is then stopped so that the pickup signals just 
before the error can be analyzed. The records can be downloaded from the device at any time. 

Proceed in the MICT as follows: 

Device -> Pickup trace 

  

 

Pickup Trace 

Example of a pickup trace for a configuration with three pickups: 

– Pickup input 1 (cam): 
Single event from the camshaft 

– Pickup input 2 (reset): 
Single event from the crankshaft 

– Pickup 3 (trigger): 
Trigger disk of Type N with 160 events from the crankshaft 
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Operation 
The following options are available via the menu in the window: 

– Open 
Opens a previously saved pickup trace 

– Save as 
Saves a pickup trace as a .putrace file 

– Close 
Closes the pickup trace 

There are the following options for the display of the pickup signals:  

– Zoom In/Out 
Using the mouse scroll wheel to zoom in or out of the displayed record range. Alternatively 
you can also use the plus and minus keys on the keyboard. The Zoom function gives you the 
possibility, for example, to also analyze the trigger signal more precisely (in the figure 
Pickup input 3). 

 
– Move displayed range 

With the right mouse button pressed you can move the displayed range along the time axis. 

– Measuring 
You can measure distances and the number of events in the displayed range by holding 
down the right mouse button to highlight a section. You can find the following information in 
the window: 

– Position on the time axis 

– Time difference (Δ) between the two selected points 
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– Number of events counted in the selected period 

 

Error analysis 
The pickup traces support you, for example, in analyzing the following errors: 

– Configuration of the pickup does not agree with the wiring (e. g. trigger disk configuration, 
allocation of the inputs, allocation of the shafts). 

– One or more pickups have failed. 

  

 

Pickup -Trace 

The pickup signals are only recorded on the inputs that are configured in 
the MICT. If the configuration of the pickup inputs is not valid (e. g. three 
signals from the same shaft), no signals are recorded. 

  
 

8.9  Access Control for the MIC5 
If the access control to the MIC5 is activated, access to the following areas is possible with a PIN 
only: 

– Runtime Adjustment (Reset, ignition timing, energy, calibration of the secondary voltage 
estimation and calibration of the secondary short-circuit monitoring) 

– Commands (Alarms, Error Commands, Set Engine/Spark plug Operating Hours, and Self 
Test) 

– Configuration (Transferring a configuration to the MIC5) 

The access control regulates the accesses to the device via the MICT. For explanations 
concerning access control to the MIC5 and the delimitation of the access levels in the MICT, refer 
to section Access Control on page 57. 

The access control functions can be accessed in the menu bar via: 

Device -> Access Control 
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8.9.1 Enabling/Disabling Access Control 
   

 

Enabling and disabling access control 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access control 
again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Resetting all 
PINs on page 71. 

  

To enable or disable the access control, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Enable or Disable the Access Control. 
2. Enter the PIN for the level Master (Level 3). 
3. Confirm the input with OK. 
 

8.9.2 Login/Logout 
If the access control is activated, you are prompted to log in if you want to execute functions that 
are allocated to a specific operating level. In addition, you can log in specifically to an operating 
level via the menu bar. 

To log into a specific operating level, proceed as follows: 

1. Open the input dialog via Device-> Access Control -> Login. 

2. First select the level you wish to log on to. 

3. Enter the PIN for the desired level. 

4. Confirm the input with OK. 

▸ You are now logged into the corresponding level and can execute all functions that are 
allocated to this operating level without having to log in again. 

After completing the log-in, you can log out again as follows: 

Device -> Access Control -> Logout 
 

8.9.3 Changing the PIN 
To change the PIN for a specific operating level, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Change PIN. 
2. First select the level for which you wish to change the PIN. 

3. Enter the current PIN for the desired level. 
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4. Enter the new PIN in the two subsequent fields. 

5. Confirm the input with OK. 

▸ The PIN for this operating level has now been changed. 
 

8.9.4 Resetting all PINs 
To reset all PINs, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Reset all PINs. 

2. If you are not yet logged into the Master (level 3) level, you will be prompted to log in with 
the relevant PIN. 

3. Accept the input with OK. 

4. To reset all PINs, you will once again be prompted to enter the PIN for the Master (level 3)  
level. 

5. Accept the input with OK. 

▸ All PINs are now reset to the value 0000. 

To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in 
case of emergency that was locked in this way, you have the following option: 

1. In the menu bar, select the entry Device -> Access Control -> Get reset all PINs request key to 
open a window with the same name. 

2. Send the request key with the serial number to your service contact partner at MOTORTECH 
(refer to Customer Service Information on page 144). This key is valid only for the respective 
controller and only for a certain amount of time. 

▸ Your information will be verified, and you will receive an authorization key from your 
contact partner. 

3. Open with the menu entry Device -> Access Control -> Input of authorization keys to reset all 
PINs of the same window name. 

4. Enter the authorization key received in the input field. 

5. Accept the input with OK. 

▸ If the input was correct, all PINs are reset to the default value 0000. 
 

8.10  Working with Configurations 
To ensure that the MIC5 correctly interprets incoming data and correctly controls the ignition 
system, it requires information about the engine and the ignition system. This information is 
stored in the MIC5 as configuration data. 

You can use the MICT to perform the following for these configurations: 

– Create 

– Open 
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– Edit 

– Save as a file 

– Download to the MIC5 

– Upload from the MIC5 
 

8.10.1 Create, Open, Save 

 

Click on the symbol to create a new configuration and select the corresponding 
device type. The device type corresponds to the first five digits of the 
arrangement number, which you can find on a label on your device. 

 

 

Click on the symbol to open a saved configuration.

 

 

Click on the symbol to save the configuration currently displayed in the MICT to 
a data carrier. 
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8.10.2 Upload, Download 

 

Click on the symbol to upload the current configuration from the MIC5 to the 
MICT. The MICT first establishes a connection to the connected MIC5 if 
necessary. 

 

Click on the symbol to download the configuration set in the MICT to the MIC5. 
This function can only be executed while the ignition is not active. This action 
overwrites the existing MICT configuration. The MICT first establishes a 
connection to the connected MIC5 if necessary. 

  

 

Existing configuration is cleared! 

If you download a configuration to a MIC5, the previous configuration is 
deleted and the new settings are immediately implemented. 

     

 

Runtime adjustments 

If you change a configuration stored in the MIC5 via runtime adjustments, 
the configuration must be re-uploaded from the device so that the changes 
are displayed in the MICT's configuration views. 

  
 

8.10.3 Compatibility Information 
The following situations can arise if you upload a configuration from the MIC5 to the MICT that 
does not correspond to the status of your MICT or if you open this type of configuration in the 
MICT: 

– No values are present in the configuration for certain MICT functions. The MICT assumes the 
standard values for these functions. 

– The configuration contains function values that are not support by the MICT. 

The following situations can arise if you download a configuration from the MICT to a MIC5 
whose firmware does not correspond to the status of your MICT: 

– No values are present in the configuration for certain firmware functions. The firmware 
continues to use the preset values for these functions. 

– The configuration contains function values that are not support by the firmware. 

If you download a configuration into the MIC5 and are notified of functions that are not 
supported by the MICT, you should check the MIC5 settings. Re-upload the configuration from 
the MIC5 to the MICT. You can then see which settings are not transmitted to the MICT. 
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Perform a firmware update, if necessary, and/or update your MICT so that you can use all the 
MIC5 functions without restriction. 
 

8.11  Configuration 
The window opens after you select the device type for a new configuration or an existing 
configuration or have uploaded one from the ignition controller. You can make changes to the 
configuration by selecting an entry from the navigation bar. The corresponding configuration 
data are then displayed in the configuration section and can be processed. The following 
sections will describe the settings and adjustments you can implement in the different areas. 
 

8.11.1 Engine – Parameters 

 

Engine Selection 
The MICT holds an engine database with data from various manufacturers and model series. 
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields. 
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the 
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output 
configuration. 

 

You can use straight order wiring, if: 

– Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH 
AlphaRail. The harness is marked with the following information: CAUTION! The firing order 
needs to be configured directly in the ignition controller. The ignition coils on the wiring rail 
are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the wiring rail is 
marked in the Wiring view. 

– Wiring of the ignition controller is done corresponding to the instructions in section Straight 
Order Wiring of the Ignition Outputs on page 46 (for example with an open wiring harness or 
via a junction box). 

The configuration of the ignition outputs is automatically adapted corresponding to your 
selection. If you want to use a different wiring, these settings must be adapted appropriately. 

If the pertinent engine is not available in the database, settings can also be entered by selecting 
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine 
Manufacturer and select the firing stroke in the column Series, then the number of cylinders, 
and the ignition offset of the engine as needed. After making your selections, the right hand 
section Engine Information will display a summary of the parameters selected. 

The summarized data are transferred to the subsequent configuration page Ignition Outputs. 
The values displayed there can only be changed by users with authorization to access the 
Advanced Service level. 



8 SETTINGS VIA THE MICT 
 

76 Rev. 04/2014 

  

 

Engine database 

MOTORTECH does not assume liability for the information in the engine 
database. Please contact MOTORTECH if discrepancies are found. 

  

New Engine Configuration 
Staff with authorization for the Advanced Service level additionally have the option of entering 
the engine data manually, i.e. without selecting entries from the engine database. For this 
purpose, click on the New Engine Configuration button and select the engine type, number of 
cycles, and number of cylinders in the dialog box opening up. Additional information can be 
entered on the configuration page Ignition Outputs. 

 

 
 



 
 

Rev. 04/2014 77 

8.11.2 Engine – Cylinder Names 

 

To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you 
can individually name each cylinder. The schematic representation of the plan view of the 
selected engine supports you in this. Enter the following settings: 

– Enable Cylinder Names 
Activate the checkbox in order to assign cylinder names. In order to use this function, the 
number of cylinders must be defined. Establish the number of cylinders either by using a 
configuration from the engine database or by creating a new engine configuration via the 
corresponding button. Refer to the section Engine – Parameters on page 74. If you have 
activated the checkbox, the assigned cylinder names must also be assigned to the 
corresponding ignition outputs, before the configuration is transferred to the ignition 
controller. Otherwise there will be an error message. Refer to the section Engine – Ignition 
Outputs on page 78. 

– Bank Name 
Enter a name for the respective cylinder bank. 

– Cylinder Names 
Enter a name for the respective cylinder.  
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–  
currently not used 

– Invert order of the banks for display 
currently not used 

 

8.11.3 Engine – Ignition Outputs 

 

Make adjustments to the following settings as needed: 

– Number of Outputs 
Select the number of outputs for the respective output bank. 

– Column: Cylinder 
Select a cylinder. The displayed names are specified on the configuration page Engine – 
Cylinder Names. 

– Column: Output 
Select the number of the respective output. 

– Column: Angle 
Enter the firing angle for each output. 
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Default Application 
If you select from the engine database, the data stored for the selected configuration are 
displayed. These data can only be changed by personnel with access to the Advanced Service 
level. 

New Engine Configuration 
If you have created a new engine configuration on the configuration page Engine – Parameters 
using the corresponding button, first the number of outputs corresponding to the number of 
cylinders are distributed to Output bank A and Output bank B. Selecting the number of outputs 
enables access to the fields for the configuration of the outputs. We recommend that you 
distribute the number of outputs evenly among the output banks and allocate the larger number 
to the A output bank if the number is uneven. 

By default, the ignition outputs are distributed so that cylinder 1 of the firing order is always 
allocated to Output bank A with a firing angle of 0°. The further distribution is implemented by 
alternating between Output bank A and B. The firing angle for each output results from the 
addition of the firing interval to the respective previous output. 

  

 

Operational safety 

Never connect more than one output to each ignition coil, as the output 
boards can otherwise be damaged! 

   
The allocation of outputs on the output banks to contacts of the output connector of the device 
and the cylinders is determined by the wiring. The user must take the wiring into account during 
the configuration; it cannot be checked by the software. 

  

 

Interval between two ignitions 

The interval between two ignitions on an output board must be min. 2.8 ms. 
During the check, the configured overspeed is used in the calculation. 
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8.11.4 Engine – Ignition Coils 

 

Ignition Coil Type 
Select the ignition coil type from the drop-down list. (Without this selection the configuration 
cannot be downloaded to the MIC5.) 

  

 

Only use measured ignition coils 

To operate the MIC5, only ignition coil types measured by MOTORTECH may 
be used. All ignition coils used must correspond to the part number 
selected in the drop-down list. Different coil types must not be mixed and 
also no equivalent or replacement types may be used. 

If a coil type used is not in the drop-down list, then the MIC5 is currently not 
used.  
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Secondary Diagnosis 
The secondary diagnosis can be deactivated and activated for ignition coils that support this 
function. If the ignition coil function is not supported, the calibration of the secondary voltage 
estimation and the calibration of the secondary short-circuit monitoring are not available. 

Secondary Voltage Estimation Calibration 
A correction value without units can be set for the secondary voltage estimation for every 
configured output to increase the accuracy of the secondary voltage estimation for each 
individual cylinder. E. g. this allows different cable lengths on the engine to be compensated. 

The values of the secondary voltage estimation can be changed for each individual cylinder. The 
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You 
can adjust the secondary voltage estimation while the engine is running in the runtime 
adjustments (refer to Runtime adjustments – Secondary Voltage Estimation Calibration on page 
126). 

Secondary Short Detection Calibration 
The starting voltage and the secondary short detection sensitivity can be adjusted. You can 
adjust the secondary short detection in the runtime adjustments while the engine is running 
(refer to Runtime adjustments – Secondary Short Calibration on page 127). 

Secondary Short Enable Voltage: 
Set the necessary average ignition voltage required to activate the secondary short-circuit 
monitoring: 

– The secondary short detection is always activated at a value of 0 kV. 

– The secondary short detection is always deactivated at a value of 65.535 kV. 

Secondary Short Sensitivity: 
The permitted value range depends on the set ignition coil. 

E. g. set the sensitivity of the short-circuit detection as follows: 

– The sensitivity is high at a value of 0.98. 

– The sensitivity is low at a value of 1.02. 
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8.11.5 Engine – Pickups 

  

  

 

Active pickups 

Check when using active pickups that the auxiliary supply voltage is 
configured for your application. 

  

Pickup Setup Information 
The settings made in the Pickup Setup section were summarized once again in the section 
Pickup Setup Information. 
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Pickup Setup 
Enter the following settings in this section: 

– Predefined Setup 
Select the pickup configuration suitable for your application from the list. The 
configurations available for selection depend on the previously entered settings. 

– Index/Reset Position 
Enter the distance between the first event after the set index/ reset marking and top dead 
center. With the button Adjust, you can enter the measured firing angle for a given nominal 
value. The system calculates the difference from these values, which is added to or 
subtracted from the index/reset position. 

– Pickup Sensitivity 
Open the pick list and select the desired sensitivity level for the pickup from the list offered. 
This setting overwrites the value of the pre-trigger-voltage if the latter was defined in the 
user-defined pickup set-up. 

– High 
The signal processing starts at low engine speeds. This setting can result in increased 
susceptibility to failure. 

– Medium 
Standard setting of the MICT. This is a trade-off between start-up speed and sensitivity. 

– Low 
The signal processing does not start until high engine speeds are reached. This setting 
can result in reduced susceptibility to failure. 

– Cam/Trigger 
Enter the number of events. The input for Cam or Trigger is automatically selected by the 
MICT and is governed by the selection of the pre-defined pickup settings. 

– Arbitrary Pickup Setup 
Staff authorized to access the Advanced Service level can, in addition to the standard 
settings access, use a manual setup option by clicking on the button Arbitrary Pickup Setup. 

 



8 SETTINGS VIA THE MICT 
 

84 Rev. 04/2014 

– Type 
Select the type of events that will occur on the respective input for each pickup input. 
Type and number of events are defined by the discs or ring gears used. If you decide not 
to use a pickup input, select the entry not used from the list. You can set the following 
types: 
N 
Disk, which causes a uniformly distributed number (N) of events (per rotation), e.g. a 
ring gear with 160 teeth (N=160). 
N+1 
Disk type N with one additional event, e.g. a disk with 12 teeth and one additional tooth 
for the index signal (N=12). 
N+1 expanded index range 
Disk type N with an additional event, e.g. with one additional disk with 12 teeth and one 
additional tooth for the index signal (N=12). The permitted range for the index signal is 
expanded to 75 % of the tooth period. An incorrect direction of rotation of the engine is 
not possible with this setting. 
N-1 
Disk type N, where one event is missing, e.g. a ring gear with 160 teeth on which one 
tooth was removed (N=160). This missing event is used to determine the index signal 
N-2 
Disk type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on 
which two teeth located next to each other were removed (N=60). This missing event is 
used to determine the index signal. 
N Magnets, Individual Magnet (not currently implemented) 
You will always use these two types together for a disk with magnets having opposite 
polarity. A fixed number (N) of the magnets has the same polarity, and a single magnet 
has the opposite polarity. Thus, the disk supplies two signals that can be analyzed by a 
pickup. Such a disk can, for example, be structured as follows: 60 magnets (N=60) point 
to the pickup with their north pole, and one magnet points to it with its south pole. All 
magnets are arranged at equal distances on the disk.  
Single Event 
Disk that supplies a single event, e.g., a disk with one tooth or one magnet. 

– Number of Events 
Enter the number of events that occur on the pickup if more than one event is expected. 
For the types N+1 and N-1, enter the value for N and not the total number of events. With 
the type N Magnets, the number of magnets with identical polarity must be entered.  
The number of events must lie between 3 and 500. Additionally, it must be ensured that 
the sum of the frequencies at the pickup input does not exceed the limit of 10 kHz at the 
pre-set overspeed. 

– Speed 
Select whether the respective pickup will pick up the signal off the camshaft or the 
crankshaft. 
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– Active/Passive 
Select the pickup to be used from the pre-defined pick list: 
Passive 
passive pickup 
Active (low) 
active pickup with High level as quiescent level 
Active (high) 
active pickup with Low level as quiescent level 

– Pre-Trigger-Voltage 
Enter a value between 0.1 V and 7.5 V for every pickup in order to set the pickup 
sensitivity. Signals that fall short of the set voltage will not be analyzed. A low pre-set 
value therefore results in a high sensitivity level, a high value results in a low sensitivity 
level. 

  

 

Pickup setup information 

The respective latest setting in the area of the pre-defined or arbitrary 
pickup settings is transferred to and displayed under Pickup Setup 
Information. 

  

Aux. Pickup Supply Voltage 
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and 
24 V is possible. 

Speed Settings 
Enter the following settings in this section: 

– Ignition Release 
Enter the release speed for the ignition at which the first ignition is to fire. The value shall 
not exceed 1/7 of the nominal speed. 

– Security Speed 
Enter the security speed (max. half the nominal speed). Below the value entered, the ignition 
can be switched on and off as desired. If the ignition is deactivated during operation above 
the set speed, the ignition cannot be immediately reactivated. Only when the ignition no 
longer reads a speed, i.e., the engine has come to a standstill, can the ignition be 
reactivated. 

– Nominal Speed 
Enter the nominal speed at which your engine is to be operated. With engines that are to be 
operated with variable speeds, the max. speed of the operating range must be entered. 
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– Overspeed 
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines 
that are to be operated with variable speeds, a speed above the operating range must be 
entered. 

– Maximum Activation Speed 
Enter the maximum permitted speed at which the MIC5 starts transmitting ignition pulses. 
A value of 6000 rpm is set as the default value: The MIC5 can be activated at the starter 
speed and immediately transmit ignition pulses. 
For a value of 0 rpm the MIC5 can only start transmitting ignition pulses once it has 
registered that the engine is at a standstill. 

 

8.11.6 Timing – Analog Inputs 
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Auxiliary supply voltage 

Check with the configuration of the analog inputs, that the set auxiliary 
supply voltage corresponds to your application. 

  

Analog Inputs Base Settings 
The timing adjustment can be made using two analog input signals, which can be set within the 
following limits: 

– Analog Current Input: 0-20 mA 

– Analog Voltage Input: 0-10 V 

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also, 
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is 
classified by the ignition controller as failure (e. g. wire break). 

You set the analog input that will be used and which timing adjustment results from the analog 
signal for the two possible schedules. Refer to the section Timing – Schedule A/B – General on 
page 88. 

Aux. Analog Input Supply Voltage 
An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value 
between 5 and 24 V. 
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8.11.7 Timing – Schedule A/B – General 

 

Schedule A General Settings 
The MIC5 offers two schedules for implementing the necessary settings for the timing of the 
engine. The schedules A and B can be used for dual fuel operation, for example. The system 
switches between the schedules via the input Schedule A/B. If only one schedule is configured 
the switch is ignored. The configuration options for schedule B are identical to those for set A.  

– Enable Schedule 
The settings are enabled or disabled by checking/unchecking the box. One schedule must 
always be activated. 

– Description 
Enter a description for the schedule (e. g. natural gas for the setting for this type of gas). 

Limits 
Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs 
will be limited to this range relative to the respective top dead center of the pertinent cylinder. 
The global timing can then not be shifted beyond this range by any adjustments. 
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Base Timing 
Enter the timing specified by the engine manufacturer. This point must be within the limits 
entered and is a static portion of the global timing. 

Potentiometer Function 
The checkbox enables and disables the potentiometer function for manually adjusting the global 
timing by the respective stops of the potentiometer set, depending on the direction of rotation. If 
the potentiometer is subsequently disabled once again, the system will no longer access the 
data during the following data transfer to the device and restart of the engine, and the device 
will no longer use this data to calculate the global ignition timing. 

Analog Inputs 
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should 
prefer the analog current input due to its lower sensitivity to faults.  

Enter the values by which the adjustment is to be implemented for the corresponding input 
signal. A Default  can be entered for the signals, if a Failure Threshold is defined in the window 
Timing – Analog Inputs for the respective entry. If the signal is below the Failure Threshold, the 
timing is offset by the error value. The offset remains until the signal again exceeds the lower set 
limit. 

Cylinder Individual Timing Limits 
Enter the maximum possible cylinder individual offset. This setting limits, among other things, 
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also 
apply to the corresponding adjustment signals from all other sources, for example via the field 
buses. 

Speed Curve 
The speed curve can be activated and disabled by mouse click and offsets the timing depending 
on the speed. A max. of eight speed points are available. If you select a number of points from 
the list, the corresponding number of fields is activated for input. 

The first speed point is always set to 0 RPM. All other timing points are assigned with the value 
by which the signal is to be offset when the respective speed is reached. For the last speed 
point, the timing of the nominal speed should be entered. Please note that the speed points 
must always be entered in ascending order. 
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8.11.8 Timing – Schedule A/B – Energy 

 

You can make different energy settings for the start phase and normal operation. 

Start Phase 
Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit  or both. 
If you enter values for both criteria, both values must also be exceeded, so that the ignition 
controller classifies the start phase as ended and sets the values for normal operation. If you 
only want to use one criterion, set the other values to 0. If you do not want to set a start phase, 
set the two values to 0. 

Enter values specific to your application for the Spark Duration, the Spark Intensity and the 
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum 
voltage expected during operation. 

Normal Operation 
If the criteria specified for the start phase are exceeded, the settings for normal operation are 
used by the ignition controller. Make the energy settings the same as for the start phase. 
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Energy Limit 
You can use the Energy Limit  field to limit the output energy made available by the ignition 
controller. If the set output energy is no longer sufficient to reach the set energy values (spark 
duration, spark intensity, max. breakdown voltage), the spark duration is reduced 
correspondingly. 

    

 

Required supply voltage for energy control 

Depending on the output configuration and the energy settings, for a 
correct energy control, a higher supply voltage than the minimum 10 V DC 
sufficient for operation of the device can be necessary. If this is the case, 
the required supply voltage is displayed in a notice in the window Timing – 
Schedule A/B – Energy. 

  
 

8.11.9 Timing – Miscellaneous 

 

You can specify how fast the changes of the timing should be executed. 



8 SETTINGS VIA THE MICT 
 

92 Rev. 04/2014 

– Maximum Firing Angle Change Per Cycle 
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both 
directions, i. e. between two firings of a cylinder. If the specified ignition timing shift is 
larger than the given value, it is divided among several cycles. 

 

8.11.10 Inputs/Outputs – Alarms 

 

The MIC5 ignition controllers include a total of 16 configurable alarms that can be allocated to 
the general purpose output. 

– Description 
You can enter any desired description for an alarm. The description is used for logging the 
alarms that have occurred in the event list in the MICT. 

– Function 
The alarms can be used depending on the following functions: 

– unused 

– Speed above threshold / below threshold 

– Engine operating hours above threshold / below threshold 
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– Spark plug operating hours above threshold / below threshold 

– Warning active 

– Error active 

– Temperature above threshold / below threshold 

– analog voltage input over threshold / under threshold 

– analog current input over threshold / under threshold 

– Global ignition timing above the threshold / below the threshold 

– Supply voltage above threshold / below threshold 

– Min. spark duration above threshold / below threshold 

– Misfire rate (primary, single output) over limit 

– Misfire rate (primary, all outputs) over limit 

– Misfires per second (primary, all outputs) over limit 

– Consecutive misfires (primary, single output) over the threshold 

– Misfire rate (secondary, single output) over limit 

– Misfire rate (secondary, all outputs) over limit 

– Misfires per second (secondary, all outputs) over limit 

– Consecutive misfires (secondary, single output) over the limit 

– Threshold 
Input of desired threshold value. 

– Hysteresis 
Input of desired hysteresis value. 

– Delay 
Input of desired delay. The threshold value defined in the alarm must have been exceeded or 
not reached for a longer period than the specified time for an alarm to be triggered. If a 
corresponding value occurs for a shorter period of time, no alarm is triggered. 

– Engine Shutdown 
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered. 

– Permanent – Keep output activated until alarm is acknowledged 
If this box is checked, the output remains permanently active until the alarm is 
acknowledged. If the box is not checked, the output remains active only for as long as the 
alarm is active. 

– Log Events 
If this box is checked, the event list records when the alarm occurred or when it was 
acknowledged. 

– Outputs 
Activate the checkbox GPO1, so that the general purpose output is activated when the alarm 
is triggered. 
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– GPO 1 
Configure the general purpose output as Normally closed or Normally open.  

 

8.11.11 Inputs/Outputs – ASO1 (auxiliary synchronization output) 

 

With the auxiliary synchronization output, freely definable impulses depending on the angle of 
the crankshaft can be generated. For the output, the user defines whether the angle will be 
absolute or based on the global timing. The output can generate between 1 and 20 impulses and 
only be assigned to one system at a time. One example of the application of the ASO output for a 
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 55. 

– No. of Points 
Select the number of impulses from the No. of Points  list. Please note that the DetCon 
detonation controller devices require a single impulse with 200 μs synchronous with the 
first cylinder in the ignition sequence. You can get this setting via the button Configure for 
DetCon2/20. 

– Angle Reference 
Select from the Angle Reference drop-down list whether the angle shall be based on the 
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter 
the trigger angle for each impulse and the length of the impulse in μs. 
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Maximum impulse duration 

Please note that the duration of the impulse can be entered as max. 300 μs. 
Input of higher values will not be accepted by the system. 

  
 

8.11.12 Inputs/Outputs – Inputs 

 

The multi-purpose input GPI1 can be used to perform a CAN-reset or a device-reset externally 
(e. g. by a master control). A high pulse of 1 second results in a reset of the CAN-driver and a high 
pulse of 5 seconds results in a device-reset. 

You can activate and disable the GPI1 using the drop-down list. 
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8.11.13 Miscellaneous – Communication 

 

CAN 
Clicking on the CAN checkbox enables or disables the CAN interface on the device.  

– ALL-IN-ONE (J1939)/CANopen 
Please select the desired protocol, depending on whether you want to set the 
communication for the ALL-IN-ONE or for another device. For example, for a connection to 
the PowerView3, select CANopen. 

– J1939 
The J1939 source address can be assigned between 0 and 253. Please note that IDs cannot 
be assigned more than once. 

– CANopen node ID 
The CANopen node ID can be assigned between 1 and 127. Please note that IDs cannot be 
assigned more than once. 

– Baud rate 
Select the desired data transfer rate from the list. The baud rate can be defined between 
50 kBit/s and 1 MBit/s, the recommended value being 250 kBit/s. 
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Modbus 
Clicking on the Modbus field enables or disables the Modbus interface on the device.  

– Modbus Address 
The Modbus address can be between 1 and 247. Please note that IDs cannot be assigned 
more than once. 

– Modbus 
Please define if the data are transferred in the ASCII or RTU mode. 

– Baud rate 
Select the desired data transfer rate from the list. The Modbus baud rate can be defined 
between 9600 and 115200 bit/s, the recommended value being 19200 bit/s. 

– Parity 
Please define if a parity bit is used and if the parity is to be even or uneven. If no parity is 
selected, then two stop bits are sent according to Modbus specification, otherwise one stop 
bit is sent. 

  

 

Setting the transfer rate 

Please note that all devices connected with a bus must be set to the same 
transfer rate. 

     

 

Information on logs 

Please contact your MOTORTECH contact partner if you require more 
information on the CANopen, J1939 and Modbus logs. 

    
 



8 SETTINGS VIA THE MICT 
 

98 Rev. 04/2014 

8.11.14 Miscellaneous – Information 
This configuration page can be viewed by all users, but changes can only be made with 
authorization for the Service access level. 

 

Site and Module 
In this section, enter information on the system and the module for which the configuration will 
be used. 

Service Contact 
In this section, individual contact data can be saved that can be called up and displayed via 
MICT. 
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8.12  Runtime Data 

 

Click on the symbol to open the window Runtime Data. The following sections will give 
you an overview of the data you can view on the individual tabs. 

You can print and record the runtime data. For this purpose, the following functions are at your 
disposal in the toolbar in the window: 

Symbol Function 

 

Prints the runtime data.

 

Prints the runtime data to a PDF file.

 

Opens the print preview.

 

Starts the runtime data trace.

 

Stops the runtime data trace.

 

Acknowledges the operating errors. If an operating error is acknowledged, all 
alarms are also simultaneously acknowledged. The symbol is grayed out if no 
acknowledged error is present.  
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8.12.1 Runtime Data – Overview 

 

In this screen, you can find the following information: 

– Speed Indicator (analog) 

– Red Pointer 
Displays the current registered speed 
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– Yellow Pointer 
Displays the maximum registered speed since last starting the engine 

– Green Pointer 
Display of set overspeed  

– Speed Indicator (digital) 
Digitally displays the current speed 

– Global Timing Point 
Digital indication of the current global timing 

– Operating Hours 

– Spark Plugs 
Indicates the current operating hours of the spark plugs 

– Engine 
Indication of current operating hours of the engine 

– Device State 
The status of the device is shown by the following status displays: 

  

Device status Description 

Idle The ignition is ready and waiting for pickup activity.

Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is 
not released. 

Wait for Stop Pickup signals are being received, the ignition fired above 
the security speed, and the ignition release was retracted. 
The engine must now come to a standstill. 

Configuration The device is being configured. 

Self Test The self test is running (refer to Self Test on page 66).

Start Phase The engine is in the configured start phase (refer to Timing –
Schedule A/B – Energy on page 90). 

Warning A warning occurred (refer to Warnings on page 114).

Error An error occurred (refer to Errors on page 115).

Alarm A configured alarm occurred (refer to Alarms on page 115).

  

– Control 

– Firing Enabled 
The green status display signals that the firing is active. 
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– Schedule A/B 
The green status display shows which parameter settings are currently used. 

– GPI1 
The status indicator shows the status of the input signal. 

– Output 

– GPO1 
The general purpose output is switched on with the green status display. 

– Failure 

– Analog Current Input 
The red status display signals that the set failure threshold for the input has been 
reached. If the lower limit of the signal is reached again, the status display is again 
gray. 

– Analog Voltage Input 
The red status display signals that the set failure threshold for the input has been 
reached. If the lower limit of the signal is reached again, the status display is again 
gray. 

– Ignition Output 
The red status display signals a current misfire on at least one output. With a yellow 
status display at least one misfire has occurred at one output since the last reset of the 
counter. 

– Misfire Rate 
The misfire rate is displayed for the primary side and the secondary side. The misfire rate on 
the secondary side is only displayed if the secondary side diagnosis is activated (refer to 
Engine – Ignition Coils on page 80). 

– Single Output 
Displays the misfire rate of the output for which the most misfires were registered 
during the last 32 cycles. 

– All Outputs 
Displays the misfire rate for all the ignition outputs for the past 32 cycles. 

– The number of misfires per second are calculated by the MIC5 as follows: 
2-stroke engine: Number of currently misfiring outputs x RPM / 60 
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2 

 



 
 

Rev. 04/2014 103 

8.12.2 Runtime Data – Timing 
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In this view, the system displays all values and settings in the left hand section that influence 
the ignition timing. In the right hand section, values are additionally displayed and shown as a 
bar chart that are measured at the three inputs (potentiometer, analog current and voltage 
input) and thus cause the changes to the timing shown. The value for the speed curve results 
from the curve progression set in the configuration. Refer to the section Timing – Schedule A/B – 
General on page 88. The timing correction can be implemented for the runtime. Please refer to 
the section Runtime Adjustments – Timing on page 124. 

In the lower range, the maximum, minimum and average of the cylinder individual offsets are 
also displayed. 
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8.12.3 Runtime Data – Ignition 

 

The following information is provided: 

– Column: Output 
Designation of the output 

– Column: Cylinder 
If cylinder names have been assigned, these are displayed 
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– Column: Estimated Secondary Voltage [kV] 
Secondary voltage determined by the ignition controller of the respective output. 
The secondary voltage estimate is used to determine deviations between the individual 
outputs. These indicate a possible problem at this output (e. g. problems in the area of the 
spark plug or the cylinder). 
If you have set the ignition coils (refer to Engine – Ignition Coils on page 80) for which a 
secondary voltage estimate does not seem possible "---" appears. 

– Column: Misfire 
The red status display signals a current misfire at the respective output. With a yellow status 
display at least one misfire has occurred at the respective output since the last reset of the 
counter.  

The coil data version configured in the MIC5 is displayed under the ignition runtime data. 
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8.12.4 Runtime Data – Bank A and B 

 

The following information is provided: 

– Column: Output 
Designation of the output 

– Column: Cylinder 
Number of the cylinder 
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– Column: Angle 
Current output firing angle 

– Column: Min. Spark Duration 
Minimum spark duration of the outputs 

– Column: Energy Output 
Current energy release of the output 

– Columns:  Misfire 
Status display for the different types of misfires (primary winding, secondary winding, open, 
short circuit). In case of misfire, the respective status display turns red, otherwise it is gray. 
With a yellow status display misfires have occurred since the last reset of the counter.  
If you hold the pointer over the status display, an overview of the misfire counter of the 
respective output is displayed for all types of misfires. A maximum up to 255 is counted per 
type of misfire. The counter manually resets using the menu item Device-> Send command -> 
Reset misfire counter. When starting the engine and starting the self test the counters are 
automatically reset. 

You have the following options: 

– Relative/Absolute 
Select via the option, whether the firing angle should be displayed absolute or relative. 
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8.12.5 Runtime Data – States 

 

Status messages are listed in the Status view. 

The following information is provided: 

– Operating Hours 
Operating hours counter reading at the time of message 
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– Time 
Date and time of the message 

– Status Message 
Message text 

Status messages are displayed in black if they are current. When a status is reset, the status 
message is displayed in grey for 10 seconds before it is deleted from the list. 

   

Statusmeldung 

Alarm shutdown caused by alarm number.

Analog current input failure (current: x mA, failure threshold: y mA, failure reset threshold: 
z mA). 

Analog voltage input failure (voltage: x V, failure threshold: y V, failure reset threshold: z V).

Aux analog input supply voltage failure (voltage: u V, desired voltage: v V, failure threshold: 
x V, failure reset threshold: y V). 

Aux pickup supply voltage failure (voltage: u V, desired voltage: v V, failure threshold: x V, 
failure reset threshold: y V). 

Configuration data checksum error. Using default configuration.

Configuration invalid. Using previous configuration.

Current sensor of output bank name failed.

Device started after supply voltage failure.

General error number. 

Global timing x° crankshaft limited to range y° crankshaft .. z° crankshaft.
Incompatible coil parameters received, secondary voltage diagnostics disabled.

Output board identification failed due to a checksum error. 

Output board identification failed due to incompatible hardware.

Output board identification failed due to missing data.

Output board identification failed due to unknown error number.

Output board identification failed due to unknown hardware. 

Pickup configuration invalid.

Power failure detected on output Anumber.

Power failure detected on output Bnumber.
Power output (x W) exceeded error threshold limit (y W) at a supply voltage of z V.

Power output (x W) exceeded limit (y W) at a supply voltage of z V.

Power output (x W) exceeded permanent limit (y W) at a supply voltage of z V.
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Statusmeldung 

PUnumber: Faulty index.

PUnumber: Faulty Signal. Signal period (x, events counted y) is too small compared to 
previous signal period (z). 

PUnumber: Index mark missing.

PUnumber: Missing index.

PUnumber: Missing Signal. Signal period (x, events counted y) is too great compared to 
previous signal period (z). 

PUnumber: Missing Signal. Signal timeout occurred (events counted x).

PUnumber: No index mark found.

PUnumber: No signal. 

PUnumber: Number of events (x) counted on pickup input PUnumber does not the match the 
expected value (y). 

PUnumber: Operational error.

PUnumber: Polarity detection failed.

PUnumber: Synchronization problem.

PUnumber: Wrong pickup signal polarity on pickup input PUnumber detected. Reversing 
polarity internally. 

Self test aborted because pickup signals have been detected on pickup input PUnumber.

Speed (x RPM) exceeded overspeed limit (y RPM) at trigger signal number.

Temperature of device (x °C) exceeded error threshold limit (y °C).

Temperature of device (x °C) exceeded limit (y °C).

Temperature of device (x °C) exceeded permanent limit (y °C).

Temperature sensor failed.
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8.12.6 Runtime Data – Message Log 

 

Information, warnings, errors and alarms are listed in the Message Log view. 

Information, warnings and errors are specified by the ignition controller, while alarms can be 
freely configured using the MICT. Refer to the section Inputs/Outputs – Alarms on page 92. 

Errors and appropriately configured alarms shut down the engine. 

The following information is provided: 
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– Operating Hours 
Operating hours counter reading at the time of message 

– Time 
Date and time of the message 

– Category 
Type of message (information, warning, error, alarm) 

– Message 
Message text 

You have the following options: 

– Automatic Scrolling 
If this box is checked, the system automatically displays the last list entry until a new event 
occurs. 

– Acknowledge Alarms 
With this button, you can reset triggered alarms if they are no longer active. An alarm can 
only be acknowledged if the checkbox Permanent - Output remains switched on until the 
alarm is acknowledged in the alarm configuration is activated.  

  

 

Acknowledging an operating error 

While the engine is in standstill, there are the following options for 
acknowledging operating errors:  

– Using Error Acknowledge  in the MICT 

– Restart / Reset 

– Hold button PB on the controller longer than three seconds 

   

 

Acknowledging warnings 

You can acknowledge a warning by briefly pressing the pushbutton PB on 
the controller.  

  

The following message texts can be displayed: 
 

Information 

Access control disabled.

All access control PINs reset.

CAN interface CANnumber entered bus off state.
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Information 

CAN interface CANnumber left bus off state.

CAN reset requested by GPInumber.

CANopen on interface CANnumber changed state to "name". 

Configuration changed. 

Date and time set. 

Device (firmware number.number.number.number) started at a supply voltage of x V.

Device reset requested by GPInumber failed because pickup signals have been detected.

Device switched off. 

Engine operating hours set to x h.

Failed to change PIN of access control level "number".

Failed to disable access control.

Failed to enable access control.

Failed to reset all access control PINs.

J1939 on interface CANnumber changed state to "name".

One or more messages are lost due to exhausted memory pool or message queue overrun.

Operational error acknowledged.

PIN of access control level "number" changed.

Self test denied because no outputs are configured.

Self test started. 

Self test stopped. 

Spark plug operating hours set to x h.

Wrong pickup signal polarity on pickup input PUnumber detected. Reversing polarity 
internally. 

 
 

Warning 

Configuration data checksum error. Using default configuration.

Configuration invalid. Using previous configuration.

Disable secondary diagnostic due to output Anumber.

Disable secondary diagnostic due to output Bnumber.

General warning number. 

Incompatible coil parameters received, secondary voltage diagnostics disabled.



 
 

Rev. 04/2014 115 

Warning 

Invalid coil data received.

Pickup configuration invalid.

Power output (x W) exceeded limit (y W) at a supply voltage of z V.

Speed (x RPM) exceeded overspeed limit (y RPM). Previous speed was z RPM.

Temperature of device (x °C) exceeded limit (y °C)

 
 

Alarm 

Alarm number  "description" acknowledged.

Alarm number  "description" triggered.

All alarms reset. 

 
 

Errors 

Alarm shutdown caused by alarm number.

Assertion failed (x). 

Critical error x (y). 

Current sensor of output bank name failed.

Cycle signal was missing, so more trigger signals were counted than available per cycle.

Device started after supply voltage failure.

General error number. 

General error in pickup pre-processing on pickup input PUnumber.

Number of trigger signals (number) counted does not match the configured value.

Operational error caused by pickup signals. PU1 = x, PU2 = y, PU3 = z.

Output board identification failed due to a checksum error. 

Output board identification failed due to incompatible hardware.

Output board identification failed due to missing data.

Output board identification failed due to unknown error number.

Output board identification failed due to unknown hardware.

Output board power failure detected on output Anumber. 

Output board power failure detected on output Bnumber. 

Power output (x W) exceeded error threshold limit (y W) at a supply voltage of z V.
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Errors 

Power output (x W) exceeded permanent limit (y W) at a supply voltage of z V.

Self test aborted because pickup signals have been detected on pickup input PUnumber.

Speed (x RPM) exceeded overspeed limit (y RPM) at trigger signal number.

Supply voltage failure. 

Temperature of controller board (x °C) exceeded limit (y °C). 

Temperature of device (x °C) exceeded error threshold limit (y °C).

Temperature of device (x °C) exceeded permanent limit (y °C). 

Temperature of output board (x °C) exceeded limit (y °C).

Temperature sensor of controller board failed.

Temperature sensor of output board failed.

Trigger period (x, triggers counted y) is not in acceptable range compared to previous trigger 
period (z). 

Trigger signal missing. Current trigger period (triggers counted x) is out of the specified 
range related to the previous trigger period. 
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8.12.7 Runtime Data – Diagnostics 

 

The following information is provided: 

– CAN Status 
The status display indicates the current error handling status of the device for the CAN bus 
communication: 
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– Error Active 
The device is in normal status of the bus communication. If an error occurs in the 
communication, the device sends an active Error Flag. 

– Error Passive 
After a defined number of errors in the bus communication, the device changes to the 
status Passive Error. If another error occurs, the device sends a passive Error Flag. 

– Bus Off 
The device is disconnected from the CAN bus due to error accumulations in the bus 
communication. 

– Controller Board 

– Supply voltage 
Current voltage supply of the controller board 

– Pickup Pre-Trigger Voltage  
Current pre-trigger voltage for the pickup inputs (refer to Engine – Pickups on page 82). 
During operation the pre-trigger voltage for passive pickups is increased depending on 
the speed, so that the ignition controller is less prone to interferences. 

– Aux. Pickup Supply Voltage 
Current auxiliary supply voltage of the pickups (refer to Engine – Pickups on page 82) 

– Aux. Analog Input Supply Voltage 
Current auxiliary supply voltage of the analog inputs (refer to Timing – Analog Inputs on 
page 86) 

– Output Board 

– Power Output 
Current output of the output board 
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8.12.8 Runtime Data – Temperatures 

 

In the window you receive an overview of the temperatures of the controller board and the 
output board. The maximum and minimum values are reset at each new start of the ignition 
controller. 

The following information is provided: 

– Controller Board 
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– Current Temp. 
Current temperature of the controller board. 

– Min. Temp. 
Minimum temperature measured on the controller board 

– Max. Temp. 
Maximum temperature measured on the controller board 

– Output Board 

– Current Temp.  
Current temperature of the output board 

– Min. Temp. 
Minimum temperature measured on the output board 

– Max. Temp. 
Maximum temperature measured on the output board 
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8.12.9 Runtime Data – Information 

 

 

In this view, you can find an overview of the device and version data. If problems arise, you can 
print the current runtime data and send them to the MOTORTECH Service Department by fax or as 
a PDF file by email. For fast support, we will then immediately have all required information. 
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8.13  Log 

 

Click on the symbol to open the window Log. This window is only available to 
users with authorizations starting at the access level Advanced Service. 

 

The window Log serves to support error diagnostics by MOTORTECH.  

– Automatic scrolling 
If the function is active, the view panel focuses on the latest message. 

– Log level 
The selection of the log level is specified by MOTORTECH if needed. 

– Write log to file 
This checkbox activates or disables, respectively, the saving of the logged data in a selected 
file. If the function is disabled, the logged data are merely shown on the display. 

– Select file 
With this button, you can select a file to which you want to save the logged data. 

If you are prompted to create a log file in the case of a service request, proceed as follows: 

1. Open the window Log via the toolbar or the menu bar. 

2. Select a path with the Select file button and enter the file name for the log file. 

▸ If the file does not yet exist, it is automatically created with the extension .log. 

3. Activate the checkbox Write log to file. 

4. Select the level specified by MOTORTECH from the Log level list. 

5. Leave the window open. 
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▸ The log messages are logged both in the window and in the selected file. 
 

8.14  Runtime Adjustments 

 

Click on the symbol to open the window Runtime Adjustments. This window is 
only available to users with authorizations starting with access level Service. 

  

 

Runtime adjustments are implemented directly 

All runtime adjustments are implemented directly without requiring the 
input to be confirmed and are retained even in the case of a MIC5 restart. 
Changes that have been saved in the device configuration are only 
displayed after re-uploading the device configuration in the MICT's main 
window. 

  
 

8.14.1 Runtime Adjustments – Reset 
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The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device 
is being operated. The correction is made with the buttons: 

– 0,1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

Changes are implemented immediately and stored in the configuration provided in the device. 

If the correction range is not sufficient, the reset/index position must be adjusted in the 
configuration (refer to Engine – Pickups on page 82). 
 

8.14.2 Runtime Adjustments – Timing 

 

The global ignition timing position can be corrected by 50°crankshaft (advanced/retarded) while 
the device is being operated. The correction is made with the buttons: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 
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– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The limit for the ignition timing set in the schedule (refer to Timing – Schedule A/B – General on 
page 88) cannot be exceeded or not reached with the runtime adjustment. 

The correction of the global ignition timing is immediately implemented and also remains in 
place if the device is restarted. NOTICE: The configuration defined in the device is not changed. 
 

8.14.3 Runtime Adjustments – Energy 

 

The energy settings can be separately adjusted for both schedules. Changes are implemented 
immediately and stored in the configuration provided in the device. 

Spark Duration 
– +/- 1 μs 

lengthen or shorten in microsecond increments 

– +/- 10 μs 
lengthen or shorten in 10 μs increments 
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Spark Intensity 
– +/- 1 mA 

increase and decrease in milliampere increments 

– +/- 10 mA 
increase and decrease in 10 mA increments 

 

8.14.4 Runtime adjustments – Secondary Voltage Estimation Calibration 

 

The secondary voltage estimation can be calibrated in this window when using ignition coils that 
support this function: 

A correction value without units can be indicated for the secondary voltage estimation for every 
output to increase the accuracy of the secondary voltage estimation for each individual cylinder. 
E. g. this allows different cable lengths on the engine to be compensated. 

The secondary voltage estimation should be calibrated under full load at a nominal speed. The 
adjustment can be made using the relevant global or individual cylinder buttons. The value 
range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders. 

Changes are implemented immediately and stored in the configuration provided in the device. 
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8.14.5 Runtime adjustments – Secondary Short Calibration 

 

The starting voltage and sensitivity for the secondary short-circuit monitoring can be adjusted. 

Changes are implemented immediately and stored in the configuration provided in the device. 

Secondary Short Enable Voltage [kV]: 
Set the necessary average ignition voltage required to activate the secondary short-circuit 
monitoring: 

– The secondary short-circuit monitoring is always activated at a value of 0 kV. 

– The secondary short-circuit monitoring is always deactivated at a value of 65.535 kV. 

Secondary Short Sensitivity 
The permitted value range depends on the set ignition coil. 

E. g. set the sensitivity of the short-circuit monitoring as follows: 

– The sensitivity is high at a value of 0.98. 

– The sensitivity is low at a value of 1.02. 
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Adjust the sensitivity of the secondary short detection 

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity 
must be set to 1.02. 

If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity must 
be set to 0.98. 

  
 

8.15  Cylinder Individual Offsets 

 

Click on the symbol to open the window Cylinder Individual Offsets. This 
window is only available to users with authorizations starting with access level 
Service. 

 

The cylinder individual offset can be applied to the position of the timing point while the 
controller is being operated. Offset via keys: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The adjustment option of this function is limited by the specified settings in the configuration. 
Refer to the section Timing – Schedule A/B – General on page 88. 

  

 

Immediate execution of the changes 

Please note that changes made to the timing point are executed 
immediately at the next firing of the corresponding cylinder. The maximum 
performed change per cycle is however limited by the corresponding setting 
in the configuration. For this read Timing – Miscellaneous on page 91. 
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Save changes automatically 

Please remember that changes to the ignition timing are saved 
automatically. 

  
 

8.16  Schedule Curve 

 

Click on the symbol to open the window Schedule.

 
 

8.16.1 Schedule Curve – Simulation 

 

The schedule curve visualizes the configurations of the schedules and simulates the influence of 
the inputs via the speed range. With the optional input fields, you can switch between schedule 
A and B. Changes made by turning the control buttons or entering the desired values are 
displayed simultaneously. 



8 SETTINGS VIA THE MICT 
 

130 Rev. 04/2014 

– Simulation 
The simulation is activated or disabled using the checkbox. 

– Potentiometer 
Simulation of the potentiometer 

– Control button for adjustments between 0 % and 100 % 

– Field for manual input of the desired value in % 

– Displays the value in °crankshaft by which the timing is offset 

– Analog Current Input 
Simulation of the analog current input 

– Control button for adjustments between the configured values (e. g. 0 mA and 20 mA) 

– Field for manual input of the desired value in mA 

– Displays the value in °crankshaft by which the timing is offset 

– Analog Voltage Input 
Simulation of the analog voltage input 

– Control button for adjustments between the configured values (e. g. 0 V and 10 V) 

– Field for manual input of the desired value in V 

– Displays the value in °crankshaft by which the timing is offset 

– Schedule A/B 
Select between schedule A and B. 

– Timing Point 
Displays the global ignition timing as it changes during the simulation 

While connected to the device, the ignition timing is simulated depending on the actual engine 
speed and marked as  in the diagram. 
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8.16.2 Schedule Curve – Runtime Values 
If the Simulation box is unchecked, the Schedule curve window switches to the current runtime 
data. 

 

The following information is provided: 

– Schedule 
Displays the currently selected schedule. 

– Left column: Potentiometer, Analog Current Input, Analog Voltage Input 
Displays the new calculated adjustment values for the potentiometer, current and voltage 
input. 

– Right column: Potentiometer, Analog Current Input, Analog Voltage Input 
Displays the values supplied by the ignition controller for the potentiometer, current and 
voltage input. 

– Speed 
Displays the current speed 

– Timing Point 
Displays the current global ignition timing 
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8.17  Coils 
The MICT has a database with technical information on MOTORTECH ignition coils. Open the 
database as follows: 

Tools -> Coils 

You have the option of storing and printing information on the ignition coils present in the 
database. For this purpose, the following functions are at your disposal in the toolbar in the 
Coils window: 

Symbol Function 

 

Stores the information on the selected ignition coils in a format that is 
appropriate for configuring the MIC5 via fieldbus. 

 

Prints the selected coil data set.

 

Prints the selected coil data set as a PDF file.

 

Opens the print preview.

Coils 
– Device 

Select an ignition controller. 

– Coil 
Select an ignition coil. 

  

 

Select the correct ignition controller 

The ignition coil data depends on the ignition controller used. Always select 
the ignition controller for which you are using the coils in order to obtain 
the correct data. 
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8.17.1 General 

 

Details 
The following information is provided: 

– Name 
Coil name 

– Coil Type ID 
Used to clearly identify the ignition coil 

– Data Version 
Shows the data version of the selected ignition coil in the database. The data version of the 
ignition coil configured in the ignition controller is displayed in the runtime data in the 
Ignition view (refer to Runtime Data – Ignition on page 105). The Automatic Online Update 
should be activated to ensure that the coil database always has the latest data sets. 
Additional information on the online update is provided in Online Update Settings on page 
65. 

– Illustration of the ignition coil 

– Information on the conditions under which a secondary diagnosis is possible using the 
displayed ignition coil. 

Coil Parameters 
The following information is provided: 
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– Max. Breakdown Voltage [kV] 
Displays the permitted value range for the maximum breakdown voltage in kV. The 
maximum breakdown voltage is configured in the Timing – Schedule A/B – Energy view 
(refer to Timing – Schedule A/B – Energy on page 90). 

– Spark Intensity [mA] 
Displays the permitted value range for the spark intensity in mA. The spark intensity is 
configured in the Timing – Schedule A/B – Energy view (refer to Timing – Schedule A/B – 
Energy on page 90). 

– Secondary Voltage Estimation Calibration 
Displays the permitted value range for the secondary voltage estimation calibration. The 
secondary voltage estimation  calibration takes place in the Engine – Ignition Coils view 
(refer to Engine – Ignition Coils on page 80) and in the runtime adjustments (refer to 
Runtime adjustments – Secondary Voltage Estimation Calibration on page 126). 

– Secondary Short Sensitivity 
Displays the permitted value range for the calibration of the secondary short sensitivity. The 
calibration of the secondary short sensitivity takes place in the Engine – Ignition Coils view 
(refer to Engine – Ignition Coils on page 80) and in the runtime adjustments (refer to 
Runtime adjustments – Secondary Short Calibration on page 127). 

 

8.17.2 Minimum Energy Limitation Curve 
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Min. Energy Limit Curve 
The curve provides information on the energy in mJ necessary to achieve a certain maximum 
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which 
a secondary diagnosis is possible. The corresponding energy settings can be found in the 
Timing – Schedule A/B – Energy view (refer to Timing – Schedule A/B – Energy on page 90). 

When printing the coil data set, the curve values are also provided as a list. 
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9.1  Start-up 
Before you start up the MIC5 ignition controller, take note of the following:  

– Were the correct engine, ignition sequence, and output configuration selected? If you are 
unsure, contact MOTORTECH or the corresponding engine manufacturer. 

– Ensure that the firing order of the engine and/or the wiring of the output cable harness are 
carried out correctly. 

– Is the wiring of all pickups compliant with the drawings given in this operating manual? 

– Are the distances of the pickups to trigger discs, projectiles, etc. correctly set (refer to 
Determine the Installation Location of the Pickup on page 26)? 

– Ensure that the data were transferred flawlessly to the controller. 

– Check whether the start/stop input is set to Firing Active, or whether it works according to 
the control requirements of the master control. 

– Check whether the input contact for parameter settings A/B (Schedule A/B) functions and 
ensure that the correct schedule (A or B) was selected for start-up. 

– Ensure that no gas is present in the inlet and exhaust systems before you start the engine. 

– Ensure that the gas valve is closed. 

– Perform the normal engine start-up process while the gas valve is closed (start only). 

– Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing 
point set on the ignition controller coincides with the actual timing point on the crankshaft. 
If the ignition timing point does not coincide exactly, change it (refer to Runtime Data on 
page 99) until the optimum setting is reached. If the ignition does not fire, read the 
instructions in section Troubleshooting and Eliminating Errors on page 141. 

– Check all other cylinders for correct ignition. If they are not correct, stop the engine, and 
recheck wiring and ignition sequence for correctness. 

– Stop the starting process. If no problems occur, start the engine in accordance with the 
specifications of the engine manufacturer. 

 

9.2  Shut-Down 
The ignition controller is shut down by disconnecting it from the power supply. 
 

9.3  Firmware Update 
Using the MOTORTECH Flash Tool, you can perform a firmware update for the ignition controller. 
The provided CD-ROM comprises this program. 

9 OPERATION 
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Install MOTORTECH Flash Tool 
This is how to install the MOTORTECH Flash Tool: 

1. Start the installation. 

– Insert the CD-ROM into the CD/DVD drive of your PC. If the Autostart function is enabled 
for the drive, cancel the installation program for the MOTORTECH Integrated 
Configuration Tool if necessary. 

– Copy the MOTORTECHFlashTool-x.x.x.zip file (e. g. MOTORTECHFlashTool-0.8.3.zip) to 
your PC. 

– Unzip the file. 

– Start the installation process by running the unzipped setup.exe file. 

2. Install the program. 
Follow the installation process instructions. Please note that the license agreement terms 
must be accepted before using the MOTORTECH Flash Tool. If the terms are not accepted, the 
installation cannot continue. 

3. If not already completed, install the USB driver by running the CDMxxxxx_Setup.exe file 
(e. g. CDM20824_Setup.exe) on the CD-ROM. 

▸ The MOTORTECH Flash Tool is now set up. You can connect your PC to the ignition 
controller via the USB interface. 

Menu Bar and Toolbar 
After launching the MOTORTECH Flash Tool, the following functions are available to you via the 
icons on the toolbar and the entries in the menu bar: 

Symbol Menu Function 

 

File -> Open Opens a firmware file.

 File -> Quit Exits the program.

 View -> Extended File Information 
View 

Fades in / out additional information of the 
firmware file. 

 View -> Extended Connection 
Settings 

Fades in / out additional information and 
settings of the connection to the device. 

 

View -> Reload File Reloads the file information of the selected 
firmware file. 

 

Device -> Search Devices Restarts the search for connected devices.
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Symbol Menu Function 

 

Device -> Program Device Starts the update process or downgrade 
process. 

 Settings -> Language Opens the window Select Language in 
which you can change the interface 
language of the program. 

 Help -> Help Opens the online help function.

 Help -> About MOTORTECH Flash 
Tool  

Opens detailed information on the 
program. 

 

Start Firmware Update 
  

 

Access control for firmware update 

If you have activated the access control for the ignition controller, you need 
the PIN for the level Master for the firmware update.  

   

 

Backup the existing configuration 

Your device's configuration may be lost if the firmware update is not 
performed properly. Always backup the existing configuration via the MICT 
prior to performing an update. For further information please refer to 
Working with Configurations on page 71. 

  

To start the firmware update, proceed as follows: 

1. If an MICT is connected with the ignition controller, please disconnect this connection. 

2. Start the MOTORTECH Flash Tool via Start -> Programs -> MOTORTECH -> MOTORTECH Flash 
Tool -> x.x.x (e. g. 0.8.3) -> MOTORTECH Flash Tool. 
▸ The MOTORTECH Flash Tool will now start. 

▸ The software automatically checks all ports for connected devices. 

3. Check whether your device has been correctly identified in Status under Device. 

▸ If the MOTORTECH Flash Tool does not recognize a device that is connected to your PC 
via the USB interface, you can usually still carry out a firmware update. To do so, 
observe the instructions in the information windows of the MOTORTECH Flash Tool for 
the following steps. 
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4. Select the desired update file in File using the Select button. 

5. By reading the displayed file information, ensure that the update file is correct for your 
device. 

6. Start the update process using the Flash button or using the menu or toolbar. 

▸ The ignition controller is restarted automatically. 

▸ Now, a window opens informing you about the firmware version currently used on your 
ignition controller and also about the relevant update version. 

7. Please confirm with Yes to proceed with the update process. 

▸ Now the update will start. 

▸ If the firmware update was successful, you will see a relevant message. 

8. After a successful firmware update, check all configuration data. 

  

 

Downgrade process 

The process for a downgrade is largely the same as the update process. You 
will only be informed that a new firmware has been installed on the device. 

   

 

Help with connection problems 

If a correctly connected device is not found during the automatic search, 
this can, for example, be because too many communication interfaces are 
assigned and must be checked. In this case an interface from the drop-
down list Port in area connection can be selected and thus specified.  

If the desired port is not yet displayed in the list or if the problem should 
continue, an adjustment of the time-outs for the connection helps. The 
time-out settings are displayed in the main view by the following entry in 
the menu bar: View -> Extended connection settings. 

Enter the following settings: 

– Update Request Timeout 
Adjustment range: 1000 ms to 10000 ms, default value: 3000 ms. An 
extension of the time-out can be an advantage, especially with 
connection problems that occur because the computer has many 
assigned ports. 

– Start Timeout 
Adjustment range: 1000 ms to 10000 ms, default value: 3000 ms. A 
time-out change can be an advantage, especially with connection 
problems that occur because the communication between the computer 
and the device has been interrupted. 
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10.1  Possible Faults 
The MIC5 ignition controllers include several safety functions that can shut down the engine in 
case of fault: 

– Overspeed protection 

– External shut-down contact (Start/Stop) 

– Misfire detection (primary) 

– Internal failure of the high voltage supply 

– Output Error Detection 

– Shut down in the case of a faulty pickup or faulty pickup signals. 

– Alarms 

– Faulty voltage supply 

– External EMI signals 
 

10.2  Causes for Faults 

10.2.1 Overspeed 
The engine speed has exceeded the set overspeed value. 

Potential causes: 

– Speed controller does not function properly 

– Fuel supply to engine is not optimal. 

– Faulty pickup signal 
 

10.2.2 Output Error Detection 
An internal failure of the high voltage supply or a defective output switch occurs. 

Potential causes: 

– Hardware defect on the MIC5 

– Defect in the wiring (short circuit or open circuit) 
 

10.2.3 Misfire Detection (Primary) 
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime 
data. 

Potential causes: 

– Defect in the output wiring 

– Ignition coil defective 
 

10 DISTURBANCES
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10.2.4 Pickup Input Errors 
Faulty input signals from the pickups are detected. 

Potential causes: 

– Number of teeth on the flywheel does not coincide with the set number. 

– Interference in the wiring of the pickup 

– Wiring of the pickup incorrect 

– Distance of the pickup incorrect 

– Dirt on the pickup 
 

10.2.5 Acknowledging Faults 
While the engine is shut down, you have the following options for acknowledging operating 
errors:  

– Using Error Acknowledge  in the MICT 

– Acknowledgement of an error via CAN bus or RS485 

– By disconnecting the supply voltage 

– Hold button PB on the controller longer than three seconds 
 

10.3  Troubleshooting and Eliminating Errors 

10.3.1 Causes of typical errors 
The table defines possible causes of errors that are dealt with in the MICT status and message 
texts. 

Issue Description Potential causes 

Trigger number Number of events per cycle 
counted does not correspond 
with set value. 

– Set value is wrong.

– Ring gear is defective. 

– Trigger disk runs out-of-center

– Faults on reset, index 
camshaft/crankshaft 

– Reset is polarized incorrectly. 

– Pickup is dirty. 

– Pickup wiring 
 is damaged. 

– Defective connection to 
pickup 
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Issue Description Potential causes 

Trigger signal 
missing 

Number of counted events is 
smaller than expected number. 

– Reset is polarized incorrectly.

– Contaminations have 
occurred on the trigger disk 
during operation. 

– Trigger disk / ring gear was 
damaged during operation. 

– Pickup wiring 
 is defective. 

Cycle signal missing Cycle signal was not detected in 
time. More events were counted 
than is expected per cycle. 

– Reset is polarized incorrectly.

– Faults on reset, index 
camshaft/crankshaft occurred

– Wiring to 
camshaft/crankshaft pickup 
is defective. 

– Trigger signal was jammed. 

Reset number Number of reset events is 
outside expected range. 

NOTICE
Only for 4-stroke engines: 
Interference coupling on reset 
signal. 

Trigger period Current event period is outside 
the valid range with reference to 
the previous event period. 

– Interference coupling on 
trigger signal 

– The wiring to the trigger 
pickup is defective. 

– The trigger pickup is dirty. 

– Trigger disk / ring gear was 
damaged during operation. 

Pickup 
preprocessing 

Pickup
 preprocessing causing errors. 

NOTICE
N+1 / N-1 trigger discs 

Overspeed Overspeed – Overspeed

– Interference coupling on 
trigger signal 

Shutdown due to 
alarm 

The ignition is shut down due to 
an alarm. 

– The limit set for an alarm 
resulting in engine shut-down 
was exceeded or not reached. 
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Issue Description Potential causes 

Temperature The max. permissible device 
temperature was exceeded. 

– Ambient temperature too high

Pickup signals in self 
test 

The self test was aborted 
because pickup signals were 
detected. 

– Interference coupling on 
pickup 
signal. 

– Engine was started 

Recognition of output 
board failed 

Characteristic data of the output 
board could not be read, they are 
defective or do not match the 
device. 

NOTICE

Send the device to MOTORTECH. 

Interruption of power 
supply to the output 
board 

The HV power supply reported an 
error. 

NOTICE

Send the device to MOTORTECH. 

Current sensor  
error 

Errors occurred during current 
measurement. 

– Sensor defective

Limit for temperature 
exceeded 

The error is triggered if the 
device temperature exceeds a 
specific value. 

– Ambient temperature too high

Limit for output 
exceeded 

The error is triggered if the 
output exceeds a specific value. 

– The supply voltage is not 
sufficient for the entered 
energy settings. 

 
A list with status messages is provided in Runtime Data – States on page 109. 

Lists with information, alarm, warning and error messages are provided in Runtime Data – 
Message Log on page 112. 
 

10.3.2 Running a Self Test 
You can run the self test via the MICT to check the order of the wiring and the connection 
between the ignition controller outputs and the spark plugs. For this read section Self Test on 
page 66. 

  

 

Operational safety! 

If you carry out a self-test, it is essential for the gas supply to be switched 
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons. 
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10.3.3 Customer Service Information 
You can reach our customer service during business hours at the following phone and fax 
number, or by e-mail: 

Phone: +49 5141 93 99 0 

Fax: +49 5141 93 99 99 

Email: service@motortech.de 
 

10.3.4 Returning Equipment for Repair / Inspection 
To return the device for repair and inspection, obtain a return form and return number from 
MOTORTECH. 

Fill out the return form completely. The completely filled out return form guarantees fast, 
uncomplicated processing of your repair order. 

Send the device and the return form to one of the two addresses below or to the nearest 
MOTORTECH representative: 

 
MOTORTECH GmbH 
Hogrevestr. 21-23 
29223 Celle 

Germany 

Phone: +49 5141 93 99 0 
Fax: +49 5141 93 99 98 

www.motortech.de 
motortech@motortech.de 

MOTORTECH Americas, LLC
1400 Dealers Avenue, Suite A 
New Orleans, LA 70123 

USA 

Phone: +1 504 355 4212 
Fax: +1 504 355 4217 

www.motortechamericas.com 
info@motortechamericas.com 

 
 

10.3.5 Instructions for Packaging the Equipment 
For return shipment, equipment should be packaged as follows: 

– Use packaging material that does not damage the equipment surfaces. 

– Wrap the equipment with sturdy materials and stabilize it inside the packaging. 

– Use sturdy adhesive film to seal the packaging. 
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11.1  Maintenance Instructions 
Please follow the following maintenance instructions: 

– Do not use caustic liquids or steam cleaners for cleaning the device.  

– Clean the passive pickups at regular intervals. 

– Check the ignition wires at regular intervals. 

– Replace the pickups at regular intervals if operating at elevated temperatures (> 90° C / > 
194° F). 

– Regularly inspect all wires of the ignition system for damage and replace the wires as 
needed. 

– Check all plug-in connections for proper condition. 

– Service the spark plugs as per the instructions of the spark plug and engine manufacturers. 

– Please observe the required tightening torques: 

– all M4 bolts: 0.8 to 1 Nm (0.6 to 0.7 lb-ft) 

– PG screw joints: 4.5 to 5 Nm (3.3 to 3.6 lb-ft) 

– Service screws: 2,5 to 3 Nm (1,9 to 2,2 lb-ft) 
 

11.2  Spare Parts and Accessories 
For spare parts and accessories for MIC5 ignition systems, please refer to our current product 
guide, which is available to you for download on the Internet at www.motortech.de. 
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